
APX N30 User Guide

APX™ Two-Way Radios
Model 2

DECEMBER 2023
© 2023 Motorola Solutions, Inc. All Rights Reserved.

*MN009363A01*
MN009363A01-AE



Contents
List of Figures......................................................................................................................8
List of Tables........................................................................................................................9
Legal and Support............................................................................................................. 10

Intellectual Property and Regulatory Notices.........................................................................................10
Legal and Compliance Statements........................................................................................................ 11

Disclaimer....................................................................................................................................11
Declaration of Conformity............................................................................................................11
ISED WLAN Statement............................................................................................................... 12
Important Safety Information.......................................................................................................12
Notice to Users (FCC).................................................................................................................13
FCC Licensing Information..........................................................................................................13
Applying for Canadian License................................................................................................... 14

Limited Warranty....................................................................................................................................14
MOTOROLA SOLUTIONS COMMUNICATION PRODUCTS.....................................................14
I. WHAT THIS WARRANTY COVERS AND FOR HOW LONG:.................................................14
II. GENERAL PROVISIONS:.......................................................................................................15
III. STATE LAW RIGHTS:............................................................................................................15
IV. HOW TO GET WARRANTY SERVICE:.................................................................................15
V. WHAT THIS WARRANTY DOES NOT COVER:.....................................................................16
VI. PATENT AND SOFTWARE PROVISIONS:...........................................................................16
VII. GOVERNING LAW:.............................................................................................................. 17
VIII. For Australia Only................................................................................................................ 17

Read Me First..................................................................................................................... 18
Software Version....................................................................................................................................18

Chapter 1: Radio Care........................................................................................................19
1.1 Cleaning Your Radio........................................................................................................................ 20
1.2 Radio Service and Repair................................................................................................................ 20
1.3 Battery Recycling and Disposal....................................................................................................... 20

Chapter 2: Radio Overview................................................................................................21
2.1 Keypad Overview.............................................................................................................................22
2.2 Programmable Radio Functions...................................................................................................... 23
2.3 ViQi.................................................................................................................................................. 26

2.3.1 Activating Basic Voice Control........................................................................................... 28
2.3.2 Using ViQi Virtual Partner.................................................................................................. 28

Chapter 3: Getting Started.................................................................................................29

MN009363A01-AE
Contents

2



3.1 Attaching and Removing the Battery............................................................................................... 29
Attaching the Battery...................................................................................................................29
Removing the Battery..................................................................................................................29

3.2 Attaching and Removing the Antenna............................................................................................. 29
Attaching the Antenna.................................................................................................................29
Removing the Antenna................................................................................................................29

3.3 Attaching and Removing the Accessory Connector Cover.............................................................. 30
Attaching the Accessory Connector Cover................................................................................. 30
Removing the Accessory Connector Cover................................................................................ 30

3.4 Attaching the Belt Clip......................................................................................................................30
3.5 Charging the Radio.......................................................................................................................... 30
3.6 Turning the Radio On or Off.............................................................................................................31

Turning the Radio On..................................................................................................................31
Turning the Radio Off.................................................................................................................. 31

3.7 Adjusting the Volume of the Radio...................................................................................................31

Chapter 4: Home Screen Overview...................................................................................32
4.1 Status Indicators.............................................................................................................................. 32

4.1.1 Status Icons....................................................................................................................... 33
4.1.2 LED Indications.................................................................................................................. 36
4.1.3 Intelligent Lighting Indicators..............................................................................................37
4.1.4 Transmit and Receive Indicators........................................................................................37

Chapter 5: General Radio Operation................................................................................ 39
5.1 Selecting Zones............................................................................................................................... 39
5.2 Selecting Channels.......................................................................................................................... 39

5.2.1 Channel Error Message..................................................................................................... 39
5.3 Mode Select Feature........................................................................................................................39

5.3.1 Saving Zones and Channels.............................................................................................. 40
5.4 Selecting the Power Level............................................................................................................... 40
5.5 Selecting a Radio Profile..................................................................................................................40
5.6 Enabling and Disabling the Radio Alias........................................................................................... 40
5.7 Adjusting the Display Backlight........................................................................................................41
5.8 Editing the Time and Date................................................................................................................41
5.9 Locking and Unlocking the Controls................................................................................................ 41
5.10 Setting the Tones for Controls and Buttons .................................................................................. 42
5.11 Setting the Voice Mute................................................................................................................... 42
5.12 Using the Time-Out Timer..............................................................................................................42
5.13 Adjusting the Squelch Level...........................................................................................................43
5.14 Conventional Squelch Operation................................................................................................... 43

5.14.1 Setting Conventional Squelch Operation......................................................................... 44

MN009363A01-AE
Contents

3



5.15 Using the PL Disable Feature........................................................................................................ 44
5.16 Digital PTT ID Support .................................................................................................................. 44
5.17 General Radio Information.............................................................................................................44

5.17.1 Accessing the General Radio Information........................................................................45

Chapter 6: Trunking System Controls..............................................................................46
6.1 Operating in Failsoft System............................................................................................................46
6.2 Imbalanced Coverage......................................................................................................................46
6.3 Out-of-Range Radio.........................................................................................................................46
6.4 Site Trunking Feature.......................................................................................................................46
6.5 Site Search...................................................................................................................................... 46
6.6 Locking or Unlocking Sites...............................................................................................................47
6.7 Viewing the Current Site.................................................................................................................. 47
6.8 Changing the Current Site............................................................................................................... 47

Chapter 7: Types of Radio Calls....................................................................................... 48
7.1 Making Calls.................................................................................................................................... 48
7.2 Receiving Calls................................................................................................................................ 49
7.3 Making Priority Dispatch Calls......................................................................................................... 50

Chapter 8: Emergency Operation..................................................................................... 51
8.1 Special Considerations for Emergency Operation........................................................................... 51
8.2 Sending Emergency Alarms............................................................................................................ 52
8.3 Sending Emergency Alarms with Emergency Calls.........................................................................52
8.4 Exiting Emergency Operation.......................................................................................................... 52
8.5 Remote Emergency......................................................................................................................... 53

8.5.1 Sending Remote Emergency to Specific Users................................................................. 53
8.5.2 Sending Remote Emergency by Entering the User ID.......................................................54
8.5.3 Manually Refreshing the Remote Emergency List............................................................. 54
8.5.4 Receiving Remote Emergency...........................................................................................54
8.5.5 Filtering Remote Emergency Contacts.............................................................................. 54

8.6 Emergency Keep-Alive.................................................................................................................... 55
8.7 Emergency Beacon..........................................................................................................................55

8.7.1 Sending Emergency Beacons............................................................................................55
8.7.2 Receiving Emergency Beacons......................................................................................... 55
8.7.3 Viewing Received Emergency Beacon.............................................................................. 55

Chapter 9: Fireground........................................................................................................56
9.1 Entering Fireground Zone Channel (Conventional)......................................................................... 56
9.2 Responding to Evacuation Indicator................................................................................................ 57
9.3 Sending Evacuation Tone................................................................................................................ 57

Chapter 10: Tactical Public Safety (Conventional Only).................................................58

MN009363A01-AE
Contents

4



10.1 Using TPS Normal Transmission...................................................................................................58
10.2 Using TPS Emergency Transmission............................................................................................ 58

Chapter 11: Man Down (Fall Alert) ...................................................................................59
11.1 Radio Alerts When Man Down (Fall Alert) is Triggered..................................................................59
11.2 Testing Man Down (Fall Alert)........................................................................................................ 60
11.3 Exiting Man Down (Fall Alert).........................................................................................................60
11.4 Reinitiating Man Down (Fall Alert)..................................................................................................60

Chapter 12: Secure Operations.........................................................................................61
12.1 Switching Between Secure and Clear Transmission..................................................................... 61
12.2 Encryption...................................................................................................................................... 61

12.2.1 Multikey Feature...............................................................................................................61
12.2.2 MDC OTAR (Conventional Only)......................................................................................62
12.2.3 Infinite UKEK Retention................................................................................................... 62
12.2.4 Hear Clear........................................................................................................................62
12.2.5 Loading Encryption Keys................................................................................................. 63
12.2.6 Selecting Encryption Keys............................................................................................... 63
12.2.7 Selecting Keysets.............................................................................................................63
12.2.8 Erasing Encryption Keys.................................................................................................. 63
12.2.9 Requesting Over-the-Air Rekey....................................................................................... 64

Chapter 13: Scan................................................................................................................65
13.1 Turning Scan On or Off.................................................................................................................. 65
13.2 Making Dynamic Priority Change (Conventional Scan Only).........................................................65
13.3 Deleting Nuisance Channel........................................................................................................... 65
13.4 Restoring Nuisance Channels....................................................................................................... 66

Chapter 14: Scan Lists.......................................................................................................67
14.1 Intelligent Priority Scan.................................................................................................................. 67
14.2 Managing the Scan List................................................................................................................. 67

Chapter 15: Connectivity...................................................................................................69
15.1 SmartConnect................................................................................................................................ 69
15.2 Wi-Fi...............................................................................................................................................69
15.3 Bluetooth®......................................................................................................................................69

15.3.1 Turning Bluetooth On or Off............................................................................................. 70
15.3.2 Searching and Pairing the Bluetooth Device....................................................................70
15.3.3 Turning Bluetooth Audio On or Off................................................................................... 70
15.3.4 Viewing and Clearing the Bluetooth Enabled Device Information....................................70

15.4 ASTRO 25 (P25) Programming Over Project 25 (POP25)............................................................ 71
15.4.1 Responding to Upgrade Notifications...............................................................................71

Chapter 16: Location .........................................................................................................72

MN009363A01-AE
Contents

5



16.1 Turning Location On or Off.............................................................................................................72
16.2 Accessing Location........................................................................................................................ 72
16.3 Selecting Location Formats........................................................................................................... 73
16.4 Managing Waypoints......................................................................................................................73
16.5 Location Feature in Emergency Mode........................................................................................... 74
16.6 Peer-Location on the Display (ASTRO Conventional)................................................................... 74
16.7 MGRS Coordinates........................................................................................................................75

Chapter 17: Mission Critical Geofence (ASTRO 25 Trunking)....................................... 76
17.1 Entry to the Geofence Area........................................................................................................... 76
17.2 Entry to Mission Critical Geofence.................................................................................................77
17.3 Exit from Mission Critical Geofence............................................................................................... 77

Chapter 18: Contacts......................................................................................................... 78
18.1 Viewing Contact Details................................................................................................................. 78

Chapter 19: Recent Calls...................................................................................................79
19.1 Viewing Recent Calls..................................................................................................................... 79
19.2 Deleting Calls.................................................................................................................................79

Chapter 20: Sending Status.............................................................................................. 81
Chapter 21: Call Alert Paging............................................................................................82

21.1 Sending Call Alert Page.................................................................................................................82
21.2 Receiving Call Alert Page.............................................................................................................. 83

Chapter 22: Automatic Registration Service................................................................... 84
22.1 Selecting ARS Mode......................................................................................................................84

Chapter 23: User Login Feature........................................................................................85
23.1 Logging In or Out of the User Login Feature................................................................................. 85

Logging In the User Login Feature..............................................................................................85
Logging Out of the User Login Feature.......................................................................................85

Chapter 24: Text Messaging Service................................................................................ 87
24.1 TMS Status Icons...........................................................................................................................87
24.2 Accessing Messages..................................................................................................................... 88

Chapter 25: Monitor Feature............................................................................................. 89
25.1 Monitoring Channels...................................................................................................................... 89
25.2 Monitoring Conventional Mode...................................................................................................... 89

Chapter 26: Remote Monitor............................................................................................. 91
Chapter 27: Transmit Inhibit..............................................................................................92

27.1 Enabling or Disabling Transmit Inhibit............................................................................................92
27.2 Smart PTT (Conventional Only).....................................................................................................92

Chapter 28: Dynamic Regrouping (Trunking Only) ........................................................94

MN009363A01-AE
Contents

6



28.1 Classification of Regrouped Radios...............................................................................................94
28.2 Requesting a Reprogram (Trunking Only)..................................................................................... 94

Chapter 29: Dynamic Zone Programming........................................................................95
29.1 Selecting Channels in the Dynamic Zone...................................................................................... 95
29.2 Deleting Channels in the Dynamic Zone........................................................................................95

Chapter 30: Multiple Private Line......................................................................................96
30.1 Selecting Multiple Private Line.......................................................................................................96

Chapter 31: Zone-to-Zone Cloning................................................................................... 97
31.1 Cloning Zones................................................................................................................................97

Chapter 32: Radio Kill .......................................................................................................98
32.1 Using Direct Kill to Kill Your Own Radio.........................................................................................98

Chapter 33: Radio Inhibit...................................................................................................99
Chapter 34: Switching between Repeater and Direct Operation................................. 100
Chapter 35: Voice Announcement.................................................................................. 101
Chapter 36: Site Selectable Alerts..................................................................................102

36.1 Sending Site Selectable Alert Notification....................................................................................102
36.2 Stopping Site Selectable Alert Notification...................................................................................102

Chapter 37: Additional Performance Enhancement..................................................... 104
37.1 ASTRO 25 Enhanced Data..........................................................................................................104
37.2 Dynamic System Resilience........................................................................................................ 104
37.3 Encrypted Integrated Data........................................................................................................... 104
37.4 SecureNet.................................................................................................................................... 104
37.5 P25 Digital Vehicular Repeater System....................................................................................... 104

Chapter 38: Accessories................................................................................................. 105

MN009363A01-AE
Contents

7



List of Figures
Figure 1: Radio Overview................................................................................................................................. 21
Figure 2: Keypad Overview.............................................................................................................................. 22
Figure 3: Home Screen Display........................................................................................................................32

MN009363A01-AE
List of Figures

8



List of Tables
Table 1: Radio Overview Description................................................................................................................21
Table 2: Keypad Overview................................................................................................................................ 23
Table 3: Assignable Radio Functions................................................................................................................23
Table 4: ViQi Basic Voice Control Commands..................................................................................................26
Table 5: ViQi Virtual Partner Queries................................................................................................................27
Table 6: Home Screen Overview Description................................................................................................... 32
Table 7: Status Icons........................................................................................................................................ 33
Table 8: LED Indications................................................................................................................................... 36
Table 9: Intelligent Lighting Indicators...............................................................................................................37
Table 10: Transmit and Receive Indicators.......................................................................................................37
Table 11: Emergency Operation Scenarios.......................................................................................................51
Table 12: TMS Status Icons..............................................................................................................................87
Table 13: TMS Inline Icons............................................................................................................................... 87
Table 14: MPL Selection Mode......................................................................................................................... 96

MN009363A01-AE
List of Tables

9



Legal and Support
Intellectual Property and Regulatory Notices
Copyrights
The Motorola Solutions products described in this document may include copyrighted Motorola Solutions
computer programs. Laws in the United States and other countries preserve for Motorola Solutions
certain exclusive rights for copyrighted computer programs. Accordingly, any copyrighted Motorola Solutions
computer programs contained in the Motorola Solutions products described in this document may not be
copied or reproduced in any manner without the express written permission of Motorola Solutions.
No part of this document may be reproduced, transmitted, stored in a retrieval system, or translated into
any language or computer language, in any form or by any means, without the prior written permission of
Motorola Solutions, Inc.

Trademarks
MOTOROLA, MOTO, MOTOROLA SOLUTIONS, and the Stylized M Logo are trademarks or registered
trademarks of Motorola Trademark Holdings, LLC and are used under license. All other trademarks are the
property of their respective owners.

License Rights
The purchase of Motorola Solutions products shall not be deemed to grant either directly or by implication,
estoppel or otherwise, any license under the copyrights, patents or patent applications of Motorola Solutions,
except for the normal nonexclusive, royalty-free license to use that arises by operation of law in the sale of a
product.

Open Source Content
This product may contain Open Source software used under license. Refer to the product installation media
for full Open Source Legal Notices and Attribution content.

European Union (EU) and United Kingdom (UK) Waste of Electrical and Electronic
Equipment (WEEE) Directive

 The European Union's WEEE directive and the UK's WEEE regulation require that products sold into
EU countries and the UK must have the crossed-out wheelie bin label on the product (or the package in some
cases). As defined by the WEEE directive, this crossed-out wheelie bin label means that customers and end
users in EU and UK countries should not dispose of electronic and electrical equipment or accessories in
household waste.
Customers or end users in EU and UK countries should contact their local equipment supplier representative
or service center for information about the waste collection system in their country.

Disclaimer
Please note that certain features, facilities, and capabilities described in this document may not be applicable
to or licensed for use on a specific system, or may be dependent upon the characteristics of a specific mobile
subscriber unit or configuration of certain parameters. Please refer to your Motorola Solutions contact for
further information.
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© 2023 Motorola Solutions, Inc. All Rights Reserved

Legal and Compliance Statements

Disclaimer
The information in this document is carefully examined, and is believed to be entirely reliable. However, no
responsibility is assumed for inaccuracies.
Furthermore, Motorola Solutions reserves the right to change any products to improve readability, function, or
design. Motorola Solutions does not assume any liability arising out of the applications or use of any product
or circuit described herein; nor does it cover any license under its patent rights, nor the rights of others.

Declaration of Conformity
Per FCC CFR 47 Part 2 Section 2.1077(a)

Responsible Party
Name: Motorola Solutions, Inc.
Address: 2000 Progress Pkwy, Schaumburg, IL 60196-1078, U.S.A.
Phone Number: 1-800-927-2744
Hereby declares that the product:
Model Name: APX N30
conforms to the following regulations:
FCC Part 15, subpart B, section 15.107(a), 15.107(d), and section 15.109(a)

Class B Digital Device
As a personal computer peripheral, this device complies with Part 15 of the FCC Rules. Operation is subject
to the following two conditions:
1. This device may not cause harmful interference, and
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2. This device must accept any interference received, including interference that may cause undesired
operation.

NOTE:
This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses, and can
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may
cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation.
If this equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the interference
by one or more of the following measures:
● Reorient or relocate the receiving antenna.
● Increase the separation between the equipment and receiver.
● Connect the equipment into an outlet on a circuit different from that to which the receiver is

connected.
● Consult the dealer or an experienced radio or TV technician for help.

For country code selection usage (WLAN devices)
NOTE: The country code selection is for non-US model only and is not available to all US models. Per
FCC regulation, all Wi-Fi products marketed in the US must be fixed to US operation channels only.

ISED WLAN Statement
CAUTION:
1. The device for operation in the band 5150–5250 MHz is only for indoor use to reduce the potential

for harmful interference to co-channel mobile satellite systems.
2. The maximum antenna gain permitted for devices in the bands 5250–5350 MHz and 5470–5725

MHz shall be such that the equipment still complies with the e.i.r.p. limit.
3. The maximum antenna gain permitted for devices in the band 5752–5850 MHz shall be such that

the equipment still complies with e.i.r.p. limits specified for point-to-point and non-point-to-point
operation as appropriate.

4. The worst case tilt angle(s) necessary to remain compliant with the e.i.r.p. elevation mask
requirement set forth in Section 6.2.2 (3) shall be clearly indicated.

5. User should also be advised that high-power radars are allocated as primary users (i.e. priority
users) of the bands 5250–5350 MHz and 5650–5850 MHz and that these radars could cause
interference and/or damage to LE-LAN devices.

Important Safety Information
RF Energy Exposure and Product Safety Guide for Portable Two-Way Radios

ATTENTION:
This radio is restricted to Occupational use only.

Before using the radio, read the RF Energy Exposure and Product Safety Guide for Portable Two-
Way Radios which contains important operating instructions for safe usage and RF energy
awareness and control for Compliance with applicable standards and Regulations.

For a list of Motorola Solutions-approved antennas, batteries, and other accessories, visit the following
website:
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https://www.motorolasolutions.com
Any modification to this device, not expressly authorized by Motorola Solutions, may void your authority to
operate this device.

Under Innovation, Science, and Economic Development Canada (ISED) regulations, this radio transmitter
may only operate using an antenna of a type and maximum (or lesser) gain approved for the transmitter
by ISED. To reduce potential radio interference to other users, the antenna type and its gain should be so
chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for successful
communication.

This radio transmitter is approved by ISED to operate with a Motorola Solutions-approved antenna with the
maximum permissible gain and required antenna impedance for each antenna type indicated. Antenna types
not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly
prohibited for use with this device.

Notice to Users (FCC)
This device complies with Part 15 of the FCC rules per the following conditions:
● This device may not cause harmful interference.
● The device must accept any interference received, including interference that may cause undesired

operation.
● Changes or modifications made to this device, not expressly approved by Motorola Solutions, could void

the authority of the user to operate this equipment.

FCC Licensing Information
This device complies with Parts 90 and 15 of the Federal Communications Commission (FCC) Rules.
Operation is subject to the condition that this device does not cause harmful interference. The radio operates
on radio frequencies that are regulated by the Federal Communications Commission (FCC). To transmit on
these frequencies, you are required to have a license issued by the FCC. Application is made available on
FCC Form 601 and Schedules D, H, and Remittance Form 159.
To obtain these FCC forms, request document 000601 which includes all forms and instructions. If you wish
to have the document faxed, mailed, or have questions, use the following contact information.
Fax

Contact the Fax-On-Demand system at 1-202-418-0177
Mail

Call the FCC forms hotline at 1-800-418-FORM or 1-800-418-3676
Contact

For questions regarding FCC license, contact 1-888-CALL-FCC, 1-888-225-5322, or http://www.fcc.gov.
Before filling out your application, you must decide which frequency you can operate on. For questions on
determining the radio frequency, call Motorola Solutions Product Services at: 1-800-448- 6686. Changes
or modifications not expressly approved by Motorola Solutions may void the user authority granted by
the FCC to operate this radio and should not be made. To comply with FCC requirements, transmitter
adjustments should be made only by or under the supervision of a person certified as technically qualified to
perform transmitter maintenance and repairs in the private land mobile and fixed services as certified by an
organization representative of the user of those services.
Replacement of any transmitter component such as crystal, semiconductor, and others not authorized by the
FCC equipment authorization for this radio could violate FCC rules.

NOTE: Use of this radio outside the country where it was intended to be distributed is subject to
government regulations and may be prohibited.
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Applying for Canadian License
The operation of your Motorola Solutions radio is subject to the Radio communications Act and must comply
with rules and regulations of the Federal Government's department of Innovation, Science, and Economic
Development Canada (ISED). ISED requires that all operators using Private Land Mobile frequencies obtain
a radio license before operating their equipment.

Prerequisites: Obtain the latest Canadian License Application form at http://www.ic.gc.ca/ic_wp-pa.htm.

Procedure:
1. Fill in the items as per the instructions. Be sure to print legibly.

If you need additional space for any item, use the reverse side of the application.
2. Make a copy of your files.
3. Prepare a cheque or money order payable to the "Receiver General for Canada", for an amount for

each radio purchased.
The license is renewed on April 1st each year, and issued for a period of 12 months.

4. Mail your completed application along with your cheque or money order to the closest ISED office.

Limited Warranty

MOTOROLA SOLUTIONS COMMUNICATION PRODUCTS

I. WHAT THIS WARRANTY COVERS AND FOR HOW
LONG:
MOTOROLA SOLUTIONS, INC. (“MOTOROLA”) warrants the MOTOROLA SOLUTIONS manufactured
Communication Products listed below (“Product”) against defects in material and workmanship under normal
use and service for a period of time from the date of purchase as scheduled below:

APX N30 One (1) Year

Product Accessories One (1) Year

MOTOROLA SOLUTIONS, at its option, will at no charge either repair the Product (with new or reconditioned
parts), replace it (with a new or reconditioned Product), or refund the purchase price of the Product during
the warranty period provided it is returned in accordance with the terms of this warranty. Replaced parts or
boards are warranted for the balance of the original applicable warranty period. All replaced parts of Product
shall become the property of MOTOROLA SOLUTIONS.
This express limited warranty is extended by MOTOROLA SOLUTIONS to the original end user purchaser
only and is not assignable or transferable to any other party. This is the complete warranty for the Product
manufactured by MOTOROLA SOLUTIONS. MOTOROLA SOLUTIONS assumes no obligations or liability for
additions or modifications to this warranty unless made in writing and signed by an officer of MOTOROLA
SOLUTIONS.
Unless made in a separate agreement between MOTOROLA SOLUTIONS and the original end user
purchaser, MOTOROLA SOLUTIONS does not warrant the installation, maintenance or service of the
Product.
MOTOROLA SOLUTIONS cannot be responsible in any way for any ancillary equipment not furnished by
MOTOROLA SOLUTIONS which is attached to or used in connection with the Product, or for operation of
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the Product with any ancillary equipment, and all such equipment is expressly excluded from this warranty.
Because each system which may use the Product is unique, MOTOROLA SOLUTIONS disclaims liability for
range, coverage, or operation of the system as a whole under this warranty.
MOTOROLA SOLUTIONS offers the following optional extended service contracts.
DEVICE MANAGED SERVICES (DMS) ACCIDENTAL DAMAGE
Provides for extended hardware repair coverage INCLUDING CHEMICAL, LIQUID, FIRE, AND OTHER
PHYSICAL DAMAGE. Accidental damage coverage is available in conjunction with MOTOROLA
SOLUTIONS’S standard Commercial Warranty and starts from the FIRST DAY the radio is put into use.
Service performed under this plan consists of repair or replacement of the covered equipment as set forth
in the terms and conditions. Repairs will be made only at the designated MOTOROLA SOLUTIONS repair
depot. Local services are not included. MOTOROLA SOLUTIONS will pay the inbound shipping charges only
with use of the MOTOROLA SOLUTIONS designated delivery service. MOTOROLA SOLUTIONS will pay for
outbound shipping via MOTOROLA SOLUTIONS'S normal shipping methods.
DEVICE MANAGED SERVICES (DMS) STANDARD HARDWARE
Provides extended hardware normal wear and tear repair coverage beginning AFTER MOTOROLA
SOLUTIONS’S standard Commercial Warranty period expires. Service performed under this plan consists
of repair of the covered equipment as set forth in the terms and conditions. Repairs will be made only
at the designated MOTOROLA SOLUTIONS repair depot. Local services are not included. MOTOROLA
SOLUTIONS will pay for outbound shipping via MOTOROLA SOLUTIONS'S normal shipping methods.

II. GENERAL PROVISIONS:
This warranty sets forth the full extent of MOTOROLA SOLUTIONS'S responsibilities regarding the Product.
Repair, replacement, or refund of the purchase price, at MOTOROLA SOLUTIONS’s option, is the exclusive
remedy. THIS WARRANTY IS GIVEN IN LIEU OF ALL OTHER EXPRESS WARRANTIES. IMPLIED
WARRANTIES, INCLUDING WITHOUT LIMITATION, IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED TO THE DURATION OF THIS LIMITED
WARRANTY. IN NO EVENT SHALL MOTOROLA SOLUTIONS BE LIABLE FOR DAMAGES IN EXCESS
OF THE PURCHASE PRICE OF THE PRODUCT, FOR ANY LOSS OF USE, LOSS OF TIME,
INCONVENIENCE, COMMERCIAL LOSS, LOST PROFITS OR SAVINGS OR OTHER INCIDENTAL,
SPECIAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE SUCH
PRODUCT, TO THE FULL EXTENT SUCH MAY BE DISCLAIMED BY LAW.

III. STATE LAW RIGHTS:
SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR
CONSEQUENTIAL DAMAGES OR LIMITATION ON HOW LONG AN IMPLIED WARRANTY LASTS, SO
THE ABOVE LIMITATION OR EXCLUSIONS MAY NOT APPLY.
This warranty gives specific legal rights, and there may be other rights, which may vary from state to state.

IV. HOW TO GET WARRANTY SERVICE:
You must provide proof of purchase (bearing the date of purchase and Product item serial number) in order
to receive warranty service and, also, deliver or send the Product item, transportation and insurance prepaid,
to an authorized warranty service location. Warranty service will be provided by MOTOROLA SOLUTIONS
through one of its authorized warranty service locations. If you first contact the company which sold you the
Product (e.g., dealer or communication service provider), it can facilitate your obtaining warranty service. You
can also call MOTOROLA SOLUTIONS at 1-800-927-2744 US/Canada.
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V. WHAT THIS WARRANTY DOES NOT COVER:
1. Defects or damage resulting from use of the Product in other than its normal and customary manner.
2. Defects or damage from misuse, accident, water, or neglect.
3. Defects or damage from improper testing, operation, maintenance, installation, alteration, modification, or

adjustment.
4. Breakage or damage to antennas unless caused directly by defects in material workmanship.
5. A Product subjected to unauthorized Product modifications, disassembles, or repairs (including, without

limitation, the addition to the Product of non-MOTOROLA SOLUTIONS supplied equipment) which
adversely affect performance of the Product or interfere with MOTOROLA SOLUTIONS's normal warranty
inspection and testing of the Product to verify any warranty claim.

6. Product which has had the serial number removed or made illegible.
7. Rechargeable batteries if:

● any of the seals on the battery enclosure of cells are broken or show evidence of tampering.
● the damage or defect is caused by charging or using the battery in equipment or service other than

the Product for which it is specified.
8. Freight costs to the repair depot.
9. A Product which, due to illegal or unauthorized alteration of the software/firmware in the Product,

does not function in accordance with MOTOROLA SOLUTIONS’s published specifications or the FCC
certification labeling in effect for the Product at the time the Product was initially distributed from
MOTOROLA SOLUTIONS.

10. Scratches or other cosmetic damage to Product surfaces that does not affect the operation of the
Product.

11. Normal and customary wear and tear.

VI. PATENT AND SOFTWARE PROVISIONS:
MOTOROLA SOLUTIONS will defend, at its own expense, any suit brought against the end user purchaser
to the extent that it is based on a claim that the Product or parts infringe a United States patent, and
MOTOROLA SOLUTIONS will pay those costs and damages finally awarded against the end user purchaser
in any such suit, which are attributable to any such claim, but such defense and payments are conditioned on
the following:
1. that MOTOROLA SOLUTIONS will be notified promptly in writing by such purchaser of any notice of such

claim,
2. that MOTOROLA SOLUTIONS will have sole control of the defense of such suit and all negotiations for

its settlement or compromise, and
3. should the Product or parts become, or in MOTOROLA SOLUTIONS’ opinion be likely to become, the

subject of a claim of infringement of a United States patent, that such purchaser will permit MOTOROLA
SOLUTIONS, at its option and expense, either to procure for such purchaser the right to continue using
the Product or parts or to replace or modify the same so that it becomes non-infringing or to grant such
purchaser a credit for the Product or parts as depreciated and accept its return. The depreciation will
be an equal amount per year over the lifetime of the Product or parts as established by MOTOROLA
SOLUTIONS.

MOTOROLA SOLUTIONS will have no liability with respect to any claim of patent infringement, which is
based upon the combination of the Product or parts furnished hereunder with software, apparatus or devices
not furnished by MOTOROLA SOLUTIONS, nor will MOTOROLA SOLUTIONS have any liability for the use
of ancillary equipment or software not furnished by MOTOROLA SOLUTIONS, which is attached to or used in
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connection with the Product. The foregoing states the entire liability of MOTOROLA SOLUTIONS with respect
to infringement of patents by the Product or any parts thereof.
Laws in the United States and other countries preserve for MOTOROLA SOLUTIONS certain exclusive
rights for copyrighted MOTOROLA SOLUTIONS software such as the exclusive rights to reproduce in copies
and distribute copies of such MOTOROLA SOLUTIONS software. MOTOROLA SOLUTIONS software may
be used in only the Product in which the software was originally embodied and such software in such
Product may not be replaced, copied, distributed, modified in any way, or used to produce any derivative
thereof. No other use including, without limitation, alteration, modification, reproduction, distribution, or
reverse engineering of such MOTOROLA SOLUTIONS software or exercise of rights in such MOTOROLA
SOLUTIONS software is permitted. No license is granted by implication, estoppel or otherwise under
MOTOROLA SOLUTIONS patent rights or copyrights.

VII. GOVERNING LAW:
This Warranty is governed by the laws of the State of Illinois, U.S.A.

VIII. For Australia Only
This provision applies to products and services supplied by Motorola Solutions to consumers within the
meaning of the Australian Consumer Law. This warranty is given by Motorola Solutions Australia Pty Limited
(ABN16 004 742 312) of Tally Ho Business Park, 10 Wesley Court. Burwood East, Victoria. Our goods come
with guarantees that cannot be excluded under the Australia Consumer Law. For major failures with the
service, you are entitled:
● To cancel your service contract with us: and
● To a refund for the unused portion, or to compensation for its reduced value.
You are entitled to choose a replacement or refund for a major failure with goods. If a failure with the
goods or service does not amount to a major failure, you are entitled to have the failure rectified in a
reasonable time. If this is not done, you are entitled to a refund for the goods, and to cancel the contract
for the service and obtain a refund of any unused portion. You are also entitled to be compensated for
any other reasonably foreseeable loss or damage from a failure in the goods or service. If you have any
queries, please call Motorola Solutions Australia at 1800 457 439. You may also visit our website: https://
www.motorolasolutions.com/en_xa/support.html for current warranty terms.
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Read Me First
This User Guide covers the basic operation of the radio.

Notations Used in This Manual
Notations such as Warning, Caution, and Notice are used throughout the text in this publication. These
notations are used to emphasize that safety hazards exist, and the care that must be taken or observed.

WARNING: An operational procedure, practice, or condition, and so on, which can result in injury or
death if not carefully observed.
CAUTION: An operational procedure, practice, or condition, and so on, which can result in damage to
the equipment if not carefully observed.
NOTE: An operational procedure, practice, or condition, and so on, which is essential to emphasize.

The following special notations identify certain items.

Example Description

Home button or Buttons and keys are shown in bold print or as an icon.

Phon Menu entries are shown similar to the way that they appear on the
display of the radio.

This means “Press the right side of the 4-Way Navigation button.”

What Your Dealer or System Administrator Can Tell You
Your dealer or system administrator can customize your radio to your specific needs. If the radio is to
be operated in extreme temperatures (less than -30 °C or more than +60 °C), check with your system
administrator for the correct radio settings.
You can consult your dealer or system administrator about the following:
● Is your radio programmed with any preset conventional channels?
● Which buttons have been programmed to access other features?
● What optional accessories suit your needs?

NOTE: Specifications vary for different radio models. For more information, contact your system
administrator.

Software Version
All the features described in the following sections are supported by the software version R31.00.00 or later.
Contact your system administrator for more details of all the supported features.
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Chapter 1

Radio Care
Proper radio usage and care ensure efficient operation and long life of the product.

CAUTION: Use the radio according to the following recommendations and warnings.
● Your radio casing has a vent port for pressure equalization in the radio. Never poke this vent with

objects such as needles, tweezers, or screwdrivers. Poking the vent could create leak paths into the
radio and the radio submergibility will be lost.

● Never obstruct or cover the vent port, even with a label.
● Ensure that no oily substances come in contact with the vent port.
● If water is observed on the vent port of radio casting, dry the vent port. Otherwise, the water blocks

the vent port and prevent pressure equalizing and could affect the overall performance of the radio.
● Your radio is designed to be submerged to a maximum depth of 6 feet and maximum time of 2

hours. Exceeding either maximum limit may result in damage to the radio.
● The radio with antenna attached properly is submersible to a maximum depth of 2 meters (6.56

feet) and a maximum submersion time of 2 hours. Exceeding either maximum limit or use without
antenna may result in damage to the radio.

● If the radio battery contacts are exposed to water without the battery attached, dry and clean the
radio battery contacts before attaching a battery to the radio. Turn the radio over with the battery
contact facing down and shake the radio so any trapped water can escape. A short circuit of the
contacts could occur if they are not dried properly.

● If the radio has been submerged in water, shake the radio to remove any water that is trapped
inside the speaker grille and microphone port. Otherwise, the water decreases the audio quality of
the radio.

● If an accessory is not attached to the radio, ensure that the accessory connector cover is attached
to the radio side accessory connector.

● If the radio is submerged or exposed to a high force water spray, such as from a hose, remove the
accessory or accessory connector cover immediately and ensure that no water is forced into the
accessory connector/radio interface. Rinse and dry the area and re-attach the accessory or
accessory connector cover if leakage occurs.

● If the radio is exposed to a corrosive environment, such as salt water or corrosive gases or liquids,
rinse and clean the radio immediately to prevent damage to radio materials, especially plated
surfaces. Remove the battery and the antenna before cleaning.

● Do not disassemble the radio as you could damage radio seals and result in leak paths into the
radio. Any radio maintenance should be performed only by a qualified radio technician.

● Only Underwriter Laboratory (UL) approved service centers can open and service UL certified
radios. Opening or repairing at unauthorized locations invalidates hazardous location rating of the
radio.

● Do not pound, drop, or throw the radio unnecessarily.
● When cleaning the radio, do not use a high-pressure jet spray as this may exceed the depth

pressure and cause water to leak into the radio.
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1.1

Cleaning Your Radio
CAUTION: Do not use solvents to clean your radio as most chemicals may permanently damage the
radio housing and textures.
Do not submerge the radio in the detergent solution.

To clean the external surfaces of your radio, perform the following:

Procedure:
1. Combine one teaspoon of mild dishwashing detergent to one gallon of water (0.5% solution).
2. Apply the solution sparingly with a stiff, non-metallic, shortbristled brush, making sure that excess

detergent does not get entrapped near the connectors, controls, or crevices.
3. Rinse and then dry the radio thoroughly with a soft, lint-free cloth.
4. Clean battery contacts with a lint-free cloth to remove dirt or grease.

1.2

Radio Service and Repair
Proper repair and maintenance procedures ensure efficient operation and long-life of this radio. A Motorola
Solutions maintenance agreement provides expert service to keep the radio and all other communication
equipment in perfect operating condition.
A nationwide service organization is provided by Motorola Solutions to support maintenance services.
Through its maintenance and installation program, Motorola Solutions makes the finest service available
to those desiring reliable continuous communications on a contract basis.
For a contract service agreement, contact your nearest Motorola Solutions service or sales representative, or
an authorized Motorola Solutions dealer.

1.3

Battery Recycling and Disposal
In the U.S. and Canada, Motorola Solutions participates in the nationwide Call2Recycle program for battery
collection and recycling. Many retailers and dealers participate in this program.
For the location of the drop-off facility closest to you, go to http://www.call2recycle.org/ or call 1-800-8-
BATTERY. This website and telephone number also provide other useful information concerning recycling
options for consumers, businesses, and governmental agencies.
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Chapter 2

Radio Overview
Figure 1: Radio Overview
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Table 1: Radio Overview Description

Number Name Description

1 Antenna Allows you to transmit and receive electromagnetic
waves during transmitting and receiving.

2 Channel Selector knob Allows you to select channel.

3 On/Off/Volume Control knob Allows you to turn on or off the radio, and adjust
the volume.

4 Status LED Provides operating status.

5 3-Dot Programmable button Programmable button of an assignable radio func-
tion.

6 Push-to-Talk (PTT) button Allows you to execute voice operations.

7 1-Dot Programmable button Programmable button of an assignable radio func-
tion.

8 2-Dot Programmable button Programmable button of an assignable radio func-
tion.
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Number Name Description

9 Speaker Outputs tones and audio that are generated by the
radio.

10 Keypad Allows menu navigation and interface selection.

11 Display The radio display screen.

12 Digital Mic 2 Allows your voice to be sent when PTT or voice
operations are activated.

13 Top Light Bar Provides indication that a radio event has occur-
red.

14 Top (Orange) button Allows you to turn on and off Emergency Opera-
tions. Besides the Emergency Operation, this but-
ton can also be configured for other features.

15 Charging Contacts Charging point for the battery.

16 Battery Provides battery power for your radio.

17 Accessory Connector Allows you to connect accessories to your radio.

18 Belt Clip Bracket Allows you to attach belt clip.

19 Digital Mic 1 Noise Cancellation Microphone.

2.1

Keypad Overview
Figure 2: Keypad Overview
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Table 2: Keypad Overview

Number Button Name Description

1 Menu Select buttons Press to access the corresponding menu.

2 Home button Press to return to Home screen.

3 Programmable button 1 (P1) This button is programmable using the Customer
Programming Software (CPS).

4 Programmable button 2 (P2) This button is programmable using the CPS.

5 4-Way Navigation buttons Press up, down, left, and right to navigate through
your options. At the Home screen, press the left
or right navigation button to display the required
menu items.

6 Notification button This button is programmable using the CPS.

2.2

Programmable Radio Functions
Your system administrator can program the programmable buttons or switches as shortcuts to radio functions
depending on the duration of a button press. Contact your system administrator to learn more about the radio
functions assigned to the programmable buttons and switches of your radio.

Table 3: Assignable Radio Functions

Function Description

Audio Playback To play the last saved call audio followed by other saved audio in
the sequence from oldest to newest.
To save the received call audio into your radio, press and hold
the button.

Basic Voice Control Activates voice commands by pressing and holding.

Beacon Allows you to check the details of any recently received Emer-
gency Beacons.

Bluetooth On/Off To turn on or off the Bluetooth, press the button.

To clear all the Bluetooth devices information, press and hold the
button.

Bluetooth Configuration Allows you to access the Bluetooth menu.

Bluetooth Audio Reroute Allows you to toggle the audio route between the radio speaker
or the Remote Speaker Microphone and the Bluetooth headset.

Bluetooth Headset PTT Enables the Bluetooth Headset microphone.

Bluetooth Inquiry On/Off Enables the Bluetooth Search feature.

Call Alert Allows the radio to function like a pager, or helps you verify if a
radio is active on the system.

Call Response Allows you to answer a private call or phone call.

Channel Announcement Allows you to hear the Voice Announcement audio file that is
assigned to the radio's current channel/mode.
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Function Description

Channel Up/Down Allows you to scroll up or down to other channels within the
current Zone.

Contacts Allows you to access the Contacts menu.

Dual Tone Multiple Frequency
(DTMF) Tone

Allows you to send out DTMF code of the assigned DTMF value.
For example, when DTMF Tone 9 is selected, you can send out
DTMF Tone 9.

Dynamic Priority (Conventional Only) Allows any channel in a Scan List (except for a Priority-One
channel) to temporarily replace the Priority-Two channel.

Emergency Allows you to send or cancel Emergency Alarm to the dispatch-
er.

Info Allows you to display the Radio Information, Internet Protocol
(IP) Display, SIM Status, Control Assignments and Soft ID (if
enabled).

Internet Protocol (IP) Allows you to display the IP address.

Keypad/Control Lock Toggles the keypad/control to lock or unlock.

Light/Flip To turn on the display backlight on and off, press the button.

Location Displays the current location (latitude, longitude, time, and date),
and also the distance and bearing to another location, or toggles
GPS/Location between on and off.

Man Down Clear Allows you to clear and deactivate the Man Down (Fall Alert)
Emergency mode alarm.

Message Allows you to access the message list.

Mode Select (MS01– MS13) To change to the preset Mode Select zone and channel, press
the button.
When the Preconfigurable Preset Zone and Channel field is
enabled, to save the current zone and channel to one of the
Mode Select menus, press and hold the preferred Mode Select
menu.

Monitor (Conventional Only) Monitors a selected channel for all radio traffic until the function
is disabled.

Multiple Private Line (Conventional
Only)

Allows you to access the Multiple Private Line lists.

Nuisance Delete Temporarily removes an unwanted channel from scan list, except
for priority channels and the designated transmit channel.

Phone Allows you to make and receive calls similar to standard phone
calls.

Private Call (Trunking Only) Allows you to dial the programmed ID (number) and initiate the
Private Call.

Private Line Disable (Conventional
Only)

Allows you to adjust squelch level of the radio between level 0
and 15 when you press and hold the button.

Priority Channel PTT If in Scan Mode and Priority Member 1 Scan List Member is in
the scan list of the current channel, the radio keys up on the
Priority 1 Scan List Member channel, therefore allowing trans-
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Function Description

mission of voice communication. Otherwise, the radio blocks the
transmission and sounds the Talk Prohibit Tone.

Priority Dispatch Allows you to call the dispatcher on a different talkgroup.

Radio Profiles Allows you to access a set of programmed visual and audio
settings of the radio.

Recent Calls Allows easy access to the list of calls recently received or made.

Rekey Request Notifies the dispatcher that a new encryption key is needed.

Remote Emergency Activates the Remote Emergency feature for an authorized user
to initiate the Emergency feature on a target radio without target
user intervention.

Repeater Access Button (RAB) (Con-
ventional Only)

Allows you to manually send a repeater access codeword.

Reprogram Request (Trunking Only) Notifies the dispatcher that a new dynamic regrouping assign-
ment is needed.

Request-To-Talk (Conventional Only) Notifies the dispatcher that you want to send a voice call.

Scan To turn on or off the scan function, press the button.

To enable Scan List Programming and selects the scan list for
editing, press and hold the button.

Select Call Calls an assigned radio.

Sensor Allows you to select the time of the Sensor Event Disable Time
operation.

Site Display/Search (Trunking Only) To display the current site ID and Received Signal Strength Indi-
cator (RSSI) value.

To perform site search for Automatic Multiple Site Select (AMSS)
or SmartZone operation, press and hold the button.

Site Lock/Unlock (Trunking Only) Allows your radio to lock onto a specific site.

Status (Trunking Only) Sends data calls to the dispatcher about a predefined status.

Talkaround/Direct (Conventional On-
ly)

Toggles between using a repeater or communicating directly with
another radio.

Talkgroup (Conventional Only) Allows a call from an individual radio to a group of radios.

Text Messaging Service (TMS) Allows you to access the Text Messaging Service (TMS) menu.

Third Party Allows you to initiate functionality in third-party accessories, such
as compatible Whelen® Sirens.

TMS Query Launches a list of predefined short text messages only after
logging in with Two-Factor Authentication.

TMS Quick Text Selects a predefined message.

Transmit Power Level Toggles between the power levels at which your radio transmits.

Unprogrammed Select this feature for a radio button that is not in use.

User Allows you to log on to the server with a personally identifiable
user name.
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Function Description

Voice Mute Allows you to mute the voice transmission of the current zone
and channel.

Volume Set Tone Sets the volume set tone.

2.3

ViQi
ViQi allows you to manage your radio and perform information lookups using voice commands. This feature
is purpose-built for easier access to features.

You are able to operate the radio with your voice using the following commands.

Table 4: ViQi Basic Voice Control Commands

Feature Examples

Battery To identify your battery level, say the following command:
● “Battery level”

Channel To identify your current channel, say the following command:
● “Channel”

Home Channel To change to your home channel, say the following command:
● “Go to home”

Preset To change the preset of your radio, say “Preset <preset number>”,
The available Preset number is from <1> to <7>.

Profile To change the profile of your radio, say the following commands:
● “Default profile”
● “Loud audio profile”
● “Surveillance profile”

Scan To start or stop scanning, say the following commands:
● “Start scanning”
● “Stop scanning”

Volume To change the volume level of your radio, say one of the available
commands according to required volume levels:
● <volume low> – 10%

● <volume medium> – 50%

● <volume high> – 100%

Zone To identify your current zone, say the following command:
● “Zone”

ViQi Virtual Partner To initiate ViQi Virtual Partner, say the following command:
● “Hey ViQi”

List of Voice Commands To view the list of voice commands, say the following command:

MN009363A01-AE
Chapter 2:  Radio Overview

26



Feature Examples

● “Go to help”

ViQi Virtual Partner
ViQi Virtual Partner helps you to look up information such as license plate, driver's license, and Vehicle ID
Number (VIN), and she responds with a result to your query.

Table 5: ViQi Virtual Partner Queries
The following table shows the queries supported by the ViQi Virtual Partner feature and their respective
commands. Use the following commands followed by the supported query instructions to initiate ViQi Virtual
Partner:
● “Look up...”
● “Check...”
● “Run a...”

Query Examples

License plate “Run a <state> license plate <alphanumeric string>”

“Check a <state> license plate”

“Look up <state> license plate <alphanumeric string>”

Driver's license “Run a <state> driver's license <alphanumeric string>”

“Check the state of <state> driver's license <alphanumeric string>”

“Look up <state> driver's license<alphanumeric string>”

Vehicle Identification
Number

“Check Vehicle Identification Number <alphanumeric string>”

“VIN check <alphanumeric string>”

“Run a VIN”
NOTE: You can use variations such as <Vehicle
Identification Number>, <VIN>, and <Vehicle Number>.

Own Location “Where am I?”
“Can I get my exact location?”
“Am I still at the <location> ?”

NOTE: ViQi will ask for more information to complete the query.

Target Location “Where is <unit name> ?”

“Tell me where <unit name> is”

NOTE: ViQi will ask for more information to complete the query.

You are also able to receive and listen to LMR and Virtual Partner over broadband audio simultaneously.
These audio mixing is configurable and must be preprogrammed by a qualified radio technician. Check with
your dealer or system administrator for more information.
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2.3.1

Activating Basic Voice Control
Prerequisites: Configure a programmable button for basic voice control.

Procedure:
1. Press and hold the programmed Basic Voice Control button.
2. Speak your command into the radio mic.
3. Release the programmed Basic Voice Control button.

Result: Basic voice control is activated and the radio operates according to the voice command.

2.3.2

Using ViQi Virtual Partner
Procedure:

1. Press and hold the programmed ViQi button.
2. After you hear a tone, speak your request into the microphone.
3. Release the assigned programmable button and wait for ViQi to respond.
4. Throughout your session, repeat steps step 1 through step 3 when responding to ViQi. Depending on

your query, you can also say the following requests:
● To play the available results, say “Play results”.
● To request for more details, say “More details”.
● To complete the Virtual Partner session, say “Complete”.
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Chapter 3

Getting Started
This section provides instructions to prepare your radio for use.

3.1

Attaching and Removing the Battery

Attaching the Battery
Procedure:

Slide the battery into the radio frame until the latches click into place.

Removing the Battery
Procedure:

1. Turn off the radio.
2. Lift the latch at the bottom of the radio.
3. Remove the battery from the radio.

3.2

Attaching and Removing the Antenna

Attaching the Antenna
Prerequisites: Ensure the radio is turned off before attaching the antenna.

Procedure:
1. Set the antenna in the receptacle.
2. Turn the antenna clockwise to attach to the radio.

Removing the Antenna
Prerequisites: Ensure the radio is turned off before removing the antenna.

Procedure:
1. Turn the antenna counterclockwise.
2. Remove the antenna from the receptacle.
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3.3

Attaching and Removing the Accessory Connector
Cover
The accessory connector is on the antenna side of the radio enables you to connect accessories to the radio.

NOTE: To prevent damage to the connector, shield it with the connector cover when not in use.

Attaching the Accessory Connector Cover
Procedure:

1. Insert the hook end of the cover into the slot above the connector.
2. Press the top of the cover downward to place it in the slot.
3. Rotate the thumbscrew clockwise.

Removing the Accessory Connector Cover
Procedure:

1. Rotate the thumbscrew counterclockwise until it disengages from the radio.
NOTE: If the thumbscrew is too tight, use an allen wrench to loosen it.

2. Rotate and lift the connector cover to disengage it from the radio.

3.4

Attaching the Belt Clip
Procedure:

Align the grooves of the belt clip with the radio and insert it until you hear a click.

3.5

Charging the Radio
Prerequisites:

WARNING:
To avoid possible explosion:
● Do not replace the battery in any area labeled Hazardous Atmosphere.
● Do not discard batteries in a fire.

When and where to use: Motorola Solutions-approved battery shipped with your radio is uncharged. Prior
to using a new battery, charge it for a minimum of 16 hours to ensure optimum capacity and performance.
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For a list of Motorola Solutions-authorized batteries and chargers available for use with your radio, see
Accessories.

NOTE: When charging a battery attached to a radio, the radio must be turned off.

Procedure:
1. Turn off the radio while charging in a single or multi-unit charger.
2. Place the radio in a Motorola Solutions-approved charger.

The LED on the charger indicates the charging progress. For more information, see the Charger User
Guide.

3.6

Turning the Radio On or Off
Prerequisites: Ensure that the battery is fully charged before the first use.

Turning the Radio On
Procedure:

To turn on, turn the On/Off/Volume Control knob clockwise until you hear a click.

Turning the Radio Off
Procedure:

To turn off, turn the On/Off/Volume Control knob counterclockwise until you hear a click.

3.7

Adjusting the Volume of the Radio
Procedure:

1. To increase the volume, rotate the On/Off/Volume Control knob clockwise.
2. To decrease the volume, rotate the On/Off/Volume Control knob counterclockwise.
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Chapter 4

Home Screen Overview
Figure 3: Home Screen Display
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Table 6: Home Screen Overview Description

Number Name Description

1 Dark Mode Status Bar Dark mode status icons appear in the status bar to
provide device status and feature notifications.

2 Bright Mode Status Bar Bright mode status icons appear in the status bar
to provide device status and feature notifications.

3 Radio Control Widget Displays the zone, channel, trunking status, and
call state.

4 Notification Widget Displays the most recent text message notification.

5 Menu Items Displays the programmed menu items.

6 Time The available time format is 12 hours (default) and
24 hours.

4.1

Status Indicators
This section explains the status indicators of the radio.
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4.1.1

Status Icons
These icons appear at the status bar to provide device-specific information or status.

Table 7: Status Icons

Icon Name Description

Battery Level Indicates the remaining battery level of the radio.
The icon blinks when the battery level drops to
10% or lower.

Broadband Network is Active Steady
The broadband system is available and connec-
ted.

Blinking
The Automatic Registration Service (ARS) user
login failed while in Broadband system.

Broadband Receiving The radio is receiving the broadband signal.

Broadband Transmitting The radio is transmitting the broadband signal.

Broadband Receiving and Trans-
mitting

The radio is receiving and transmitting the broad-
band signal.

Broadband with ARS User Log-
ged In

The ARS user logged on successfully with the
broadband system.

Broadband Receiving while ARS
User Logged In

The ARS user logged on successfully with the
broadband system.

Broadband Transmitting while
ARS User Logged In

The radio is transmitting a broadband signal with
the ARS user logged on.

Broadband Receiving and Trans-
mitting while ARS User Logged
In

The radio is receiving and transmitting broadband
signals with the ARS user logged on.

Bluetooth® On The Bluetooth wireless technology is turned on and
ready for connection.

Bluetooth Connectivity Steady
Bluetooth is connected to the external Bluetooth
device.

Blinking
The Bluetooth device is disconnected.
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Icon Name Description

Call Received The radio received a call.

Direct Mode The radio is configured for direct radio-to-radio
communication in conventional operation.

Global Positioning System
(GPS)

GPS is enabled and the signal is available.

In-Call User Alert The receiving audio turns off.

Data Activity Data activity is present on the radio.

Regular

Inverted

User Login Indicator (IP Packet
Data)

Steady
The user is associated with the radio.

Blinking
The device registration or user registration with
the server failed due to an invalid username or
pin.

Inverted
The user is logged on to the secured IP packet
data.

Monitor The selected channel is being monitored in con-
ventional operation.

Roaming The radio has roamed to and is registered to a
foreign system.

Received Signal Strength Indica-
tor (RSSI)

The number of bars represents the received signal
strength of the current site in trunking mode.

RSSI Out of Range The received signal is too far to be detected.

Receiving The radio is receiving a call or data.

Transmitting The radio is transmitting a call or data.

Satellite Network is Active Steady
The satellite system is available and connected.

Blinking
The ARS user login failed while in the satellite
system.
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Icon Name Description

Satellite Receiving The radio is receiving a satellite signal.

Satellite Transmitting The radio is transmitting a satellite signal.

Satellite Receiving and Transmit-
ting

The radio is receiving and transmitting satellite sig-
nals.

Satellite with ARS User Logged
In

The ARS user logged on successfully with the sat-
ellite system.

Satellite Receiving while ARS
User Logged In

The ARS user logged on successfully with the sat-
ellite system.

Satellite Transmitting while ARS
user Logged In

The radio is transmitting a satellite signal with the
ARS user logged on.

Satellite Receiving and Transmit-
ting while ARS User Logged In

The radio is receiving and transmitting satellite sig-
nals with the ARS user logged on.

SmartConnect Capable The current channel is capable of supporting
SmartConnect.

SmartConnect Connected The current channel is currently connected through
the SmartConnect feature.

Scan The radio is scanning a scan list.

Priority Channel Scan Steady
The radio detects activity on the designated Pri-
ority-Two channel.

Blinking
The radio detects activity on the designated Pri-
ority-One channel.

Vote Scan The Vote Scan feature is enabled.

Secure Operation Steady
The radio is operating in a secure channel.

Blinking
The radio is receiving an encrypted voice call.

Advanced Encryption Standard
(AES) Secure Operation

Steady
The radio is operating in an AES-secure chan-
nel.
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Icon Name Description

Blinking
The radio is receiving an AES-encrypted voice
call.

Power Level High The radio is set at high power.

Power Level Low The radio is set at low power.

Virtual Private Network (VPN) VPN is activated on the radio.

Wi-Fi Strength Your radio is connected to a Wi-Fi network. The
number of bars represents the signal strength of
the Wi-Fi network.

Wi-Fi Unavailable Wi-fi network cannot be reached.

4.1.2

LED Indications
The LED indications represent the operational status of your radio. A qualified technician can permanently
disable the LED indication by preprogramming it.

Table 8: LED Indications

Indication Status

Solid red Radio is transmitting.

Blinking red Radio is transmitting at low battery condition or detects an incompatible bat-
tery.

Double blinking red Radio is transmitting an emergency alarm or call.

Rapid blinking red Radio has failed the self-test upon powering up or encountered a fatal error.

Solid yellow Radio is receiving in both trunking and conventional clear mode.
NOTE: The yellow LED will illuminate only when the busy LED feature
is enabled through Customer Programming Software (CPS).

Blinking yellow Radio is receiving a secured transmission.

Solid green Radio is powering up.

Blinking green Radio is receiving an individual or telephone call.
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4.1.3

Intelligent Lighting Indicators
This feature temporarily changes the color of the Top Light Bar and adds a color bar to the main display
screen to help signal that a radio event has occurred.

Table 9: Intelligent Lighting Indicators

Backlight and Bar
Color

Notification When

Orange Emergency Alerts The radio initiates an emergency alarm or call.

The radio receives an emergency alarm or call.

The radio initiates the Fall Alert (Man Down) Post-
Alert timer.

Red Critical Alerts The radio battery is low.

The radio is out of range.

The radio enters Failsoft mode.

The radio is unable to establish a full connection
with the system.

The radio is unable to authenticate or register with
the system.

The radio lost the Global Positioning System
(GPS) signal or the GPS function fails.

Green Call Alerts The radio receives a private call.

The radio receives a phone call.

The radio receives a call alert.

The radio receives a selective call.

The radio enters Geofence.

4.1.4

Transmit and Receive Indicators
The Transmit and Receive Indicator indicates the active call state of the radio.

Table 10: Transmit and Receive Indicators

Indicator Light Bar Color Call State

Light Blue Open or Standby
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Indicator Light Bar Color Call State

Yellow Receiving and Unmuted

Red Voice Transmission

Light Blue Out of Range

Light Blue Smart Connect

Gray Unprogrammed

Gray Receiving Frequency Error
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Chapter 5

General Radio Operation
This chapter explains the general operations of your radio.

5.1

Selecting Zones
A zone is a group of channels.

Procedure:
1. Press the Zone menu item.
2. Select the required zone and press Sel.

5.2

Selecting Channels
A channel is a group of radio characteristics, such as transmit or receive frequency pairs.

Procedure:
Select channels by using the following options.

Option Actions

Selecting radio channels using the
Channel Selector knob

Rotate the Channel Selector knob to the required channel.

Selecting radio channels from the
Menu

a. Press the Chan menu item.
b. Select the required channel and press Sel.

5.2.1

Channel Error Message
If there is a channel error, your radio displays error messages on the Radio Control Widget.

Type Description

Unprogrammed The mode is set to an unprogrammed channel.

Fail 001 The selected channel is assigned to an incorrect frequency band.

5.3

Mode Select Feature
The Mode Select feature allows you to save the current zone and channel on your radio to one of the Mode
Select feature menus (MS01–MS05) on a programmable side button (MS01–MS13).
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When programmed, pressing the button changes the transmission to the saved zone and channel. When
the Preconfigurable Preset Zone and Channel field is enabled, pressing and holding the preferred Mode
Select menu saves the current zone and channel to one of the Mode Select menus. The radio displays MS0x
is programmed.

NOTE: Your radio must be programmed for you to use this feature.

5.3.1

Saving Zones and Channels
You can save frequently used zones and channels to the programmable buttons.

Prerequisites: Enable the Preconfigurable Preset Zone and Channel field.

Procedure:
1. Toggle from your current zone and channel to the required zone and channel.
2. To save zones and channels to a button, press and hold the button you want to program.

Result:
If the zone and channel is saved, a tone sounds.
If the Preconfigurable Preset Zone and Channel field is disabled, a negative tone sounds.

NOTE: Short press of the programmed button changes your current transmission to the zone and
channel programmed in the button.

5.4

Selecting the Power Level
This feature enables you to select the power level at which your radio transmits. Power level Low enables
a shorter transmitting distance and power consumption. Power level High enables a longer-transmitting
distance.

Prerequisites: This feature must be programmed by a qualified radio technician.

Procedure:
Switch to the required power level by pressing the Pwr menu item.

Result: The display shows Low power and the Power Level Low icon or the display shows High power
and the Power Level High icon.

5.5

Selecting a Radio Profile
Procedure:

1. Press the Prfl menu item.
2. Select the required radio profile and press Sel.

5.6

Enabling and Disabling the Radio Alias
This feature allows you to display or hide the radio alias (name).
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Procedure:
Enable or disable the radio alias by pressing the MyID menu item.

Result: The display shows momentary Radio ID off, and the radio alias disappears from the Home
screen or the display shows momentary Radio ID on, and the radio alias appears on the Home screen.

5.7

Adjusting the Display Backlight
You can enable or disable the radio display backlight as needed, if poor light conditions make the display or
keypad difficult to read.

NOTE: The backlight setting also affects the Menu Select buttons and Navigation button backlighting
accordingly.
The backlight remains on for a programmed time before it automatically turns off completely or returns
to the minimum backlight level.

Procedure:
Perform one of the following actions:
● To turn the backlight on or off, press the programmed Light/Flip button.
● To turn the backlight on, press either the Menu Select or Navigation button, or any programmable

radio controls or buttons.

5.8

Editing the Time and Date
Procedure:

1. Press the Clck menu item.
2. Press Edit.
3. Perform one of the following actions:

● To save, select the required time and date. Press Ok.
● To cancel, press Cncl.
● To return to the home screen and discard your changes, press the Home button.

5.9

Locking and Unlocking the Controls
You can lock your radio keypad, programmable buttons, and knob or knobs to avoid inadvertent entry. Check
with your dealer or qualified technician for best selection to suit your usage.

Procedure:
1. To lock the controls, press the programmed Keypad/Control Lock button.

The display shows Kypd/Ctrl Lock.

2. To unlock the controls, press the button again.
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5.10

Setting the Tones for Controls and Buttons 
If needed, you can enable or disable the tones of navigation buttons and controls.

Procedure:
Turn the tones on or off by pressing the Mute menu item.

Result:
The display shows a notification message indicating if the tones are enabled or disabled.
If the tones are enabled, you hear a short tone.

5.11

Setting the Voice Mute
This feature allows you to mute the voice transmission of the current zone and channel.

Procedure:
Turn Voice Mute on or off by pressing the VMut menu item.

Result:
If Voice Mute is successfully turned on, your radio shows the following indications:
● A short tone sounds.
● The display shows Voice mute on.

If Voice Mute is successfully turned off, your radio shows the following indications:
● A short tone sounds.
● The display shows Voice mute off.

5.12

Using the Time-Out Timer
This feature turns off the transmitter of your radio. You cannot transmit longer than the preset timer setting. If
you attempt to do so, the radio automatically stops your transmission, and you hear a talk-prohibit tone.

NOTE: The default timer is 60 seconds. Contact your system administrator to adjust the timer duration.

Procedure:
1. Press and hold the PTT button longer than the programmed time.

The radio shows the following indications:
● A tone sounds.
● The transmission is cut off.
● The LED extinguishes.

2. To reset the timer, release the PTT button.
3. To retransmit, press the PTT button.

The time-out timer restarts, and the red LED illuminates.

MN009363A01-AE
Chapter 5:  General Radio Operation

42



5.13

Adjusting the Squelch Level
The Adjustable Fine Tune Squelch feature allows you to adjust the desired squelch level of the radio between
level 0 and 15.
The following settings determine the types of call that you receive:
● 0 – Squelch is open and all calls regardless of signal strength and background noise pass through.
● Lower setting – Calls with low signal strength and higher than normal background noise pass through.
● Higher Setting – Calls with low signal strength and higher than normal background noise are filtered out.

Procedure:
1. From the Home screen, press and hold the preprogrammed Private Line Disable button.

The radio displays the Squelch menu.

2. To adjust the squelch level, perform one of the following actions:
● Press - or +.
● Press the Left or Right navigation button.

3. To return to the Home screen, press the Home button.

5.14

Conventional Squelch Operation
This feature filters out unwanted calls with low signal strength or channels that have a higher than normal
background noise.

Analog Options
Tone Private Line, Digital Private-Line, and carrier squelch is available and programmed per channel.

Option Result

Carrier squelch You hear all traffic on a channel.

Tone Private Line or Digital Private-Line The radio responds only to your messages.

Digital Options
One or more of the following options can be programmed in your radio. For more information, contact your
system administrator.

Option Result

Digital Carrier-Operated Squelch You hear all digital traffic.

Normal Squelch You hear any digital traffic having the correct net-
work access code.

Selective Switch You hear any digital traffic having the correct net-
work access code and correct talkgroup.
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5.14.1

Setting Conventional Squelch Operation
Procedure:

1. Press the Sql menu item.
2. Perform one of the following actions:

● To increase the squelch volume, press +.
● To decrease the squelch volume, press -.

3. To return to the selected channel, press the Home button.

5.15

Using the PL Disable Feature
This feature allows you to override any coded squelch that preprogrammed to a channel. The radio also
unmutes to any digital activity on a digital channel. When this feature is active, the Carrier Squelch status
indicator is displayed.

Procedure:
Turn on the PL Disable feature by pressing the programmed PL Disable button.
One of the following results occurs:
● The radio plays the active transmission on the channel.
● If no activity is present, the radio is muted

5.16

Digital PTT ID Support 
This feature allows you to see the radio ID (number) of the radio from whom you are currently receiving a
transmission. The receiving radio and the dispatcher can view the ID, which consists of up to a maximum of
eight characters.
The ID number of your radio is also automatically sent every time you press the PTT button. This feature is
preprogrammed per channel. For digital voice transmissions, the ID of your radio is sent continuously during
the voice message.

5.17

General Radio Information
This menu item allows you to view general information of your radio.
The available information are:
● Radio Information
● IP Information
● Control Map
● Certificates
● IoT Status
● Voice Commands
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5.17.1

Accessing the General Radio Information
Procedure:

1. Press the Info menu item.
2. Perform one of the following actions:

● To view radio information, press Radio Info.
● To view IP information, press IP Info.
● To view Control Map, press Control Map.
● To view Certificates, press Certificates.
● To view IoT status, press IoT Status.
● To view programmed voice commands, press Voice Commands.
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Chapter 6

Trunking System Controls
This chapter explains the trunking system control features on your radio.

6.1

Operating in Failsoft System
The failsoft system ensures continuous radio communication during a trunked system failure. If a trunking
system fails completely, the radio goes into failsoft operation and automatically switches to its failsoft channel.
To continue in Failsoft and to communicate with other talkgroups, refer to the following procedure.

Procedure:
1. Rotate the Channel Selector knob to change to a different repeater frequency.
2. To call, press and hold the PTT button.
3. To listen, release the PTT button.

6.2

Imbalanced Coverage
Imbalanced coverage occurs when the radio is able to receive the control channel but is unable to transmit
back to the system. The radio generates a periodic tone and displays No Comms.

6.3

Out-of-Range Radio
When your radio goes out of the range of the system, it can no longer lock onto a control channel.
You hear a low-pitched tone and/or the display shows the currently selected zone/channel combination and
Out of range notification. Your radio remains in this out-of-range condition until it locks onto a control channel
or failsoft channel, or if it is turned off.

6.4

Site Trunking Feature
If the Zone Controller loses communication with any site, that site reverts to site trunking. When this occurs,
you can communicate only with the radios within your trunking site.
The display shows the currently selected zone/channel and the Site Trunking message.

6.5

Site Search
When searching for a site, your radio is inoperable. In the site search mode, your radio scans for trunked
control channels but has yet to connect to the trunking system or reach other trunking states. Other trunking
states are such as Out of Range and Imbalanced Coverage.
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The Searching site indicator alerts you that your radio is attempting to search for a valid trunked control
channel.

6.6

Locking or Unlocking Sites
This feature allows your radio to lock onto a specific site and not roam among wide-area talkgroup sites. This
feature must be used with caution because it inhibits roaming to another site in a wide-area system.

Procedure:
1. Press the Site menu item.
2. Perform one of the following actions:

● To lock the site, press Lock.
● To unlock the site, press Unlk.

Result: The display shows a notification to indicate if the site is locked or unlocked. The radio saves the new
site lock state and returns to the Home screen.

6.7

Viewing the Current Site
Procedure:

Press the programmed Site Displ/Srch button.
Result: The display shows the name of the current site and corresponding received RSSI.

6.8

Changing the Current Site
Procedure:

Press and hold the programmed Site Displ/Srch button.
Result:
The radio shows the following indications:
● A tone sounds.
● The display shows momentary Scanning site.

When the radio finds a new site, it returns to the Home screen.
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Chapter 7

Types of Radio Calls
Your radio can make a Talkgroup, Private, Selective, and Telephone call in conventional and/or trunking
mode.

Call Type Conventional
Mode

Trunking Mode SmartConnect

Talkgroup Call
This feature is a point-to-multipoint call
operation. Your radio must be configured
as a member of the talkgroup for you to
communicate within the talkgroup.

Private Call
This feature is a call from one individual
radio to another.

Selective Call
This feature is a call from an individual
radio to another individual radio with pri-
vacy.

Telephone Call
This feature allows you to receive calls
similar to standard phone calls from a
landline phone.

7.1

Making Calls
Procedure:

Make calls by using the following options.

Option Actions

Talkgroup Call a. To transmit, press and hold the PTT button.
b. Wait for the Talk Permit Tone. Then, speak into the micro-

phone.
c. To listen, release the PTT button.

NOTE: You cannot transmit longer than the preset Time-
Out Timer setting. If you attempt to do so, the radio auto-
matically stops your transmission, and you hear a tone.

MN009363A01-AE
Chapter 7:  Types of Radio Calls

48



Option Actions

Private Call a. Enter the Contacts page by pressing the Cnts menu item.
b. Select the required preprogrammed contact.
c. Start the call by pressing the PTT button.
d. To end the call, press Exit.

Selective Call a. Enter the Contacts page by pressing the Cnts menu item.
b. Select the required preprogrammed contact.
c. Start the call by pressing the PTT button.
d. To end the call, release the PTT button.

Telephone Call a. Press the Phon menu item.
The display shows the last transmitted or received ID.

b. To select the required ID, perform one of the following actions:
● Press Cnts.
● To go to the last dialed number, press LNum.

c. To dial the phone number, press the PTT button.
d. To talk, press and hold the PTT button and speak into the

microphone.
e. To listen, release the PTT button.

7.2

Receiving Calls
Procedure:

Receive calls by using the following options.

Option Actions

Talkgroup Call No action is required. Your radio automatically plays the transmis-
sion from the talkgroup call.

Private Call When you receive private calls, your radio shows the following
indications:
● A tone sounds.
● The green LED blinks.
● This display shows Call received, and the Call Received

icon blinks.
a. Respond by performing one of the following actions:

● To reject the call, press Exit.
● To accept the call, press Resp.

b. To talk, press and hold the PTT button.
c. To listen, release the PTT button.
d. To end the call, press End.
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Option Actions

Selective Call For incoming Selective Calls, your radio automatically plays the
transmission from the call.
a. Respond to the call by pressing and holding the PTT button.
b. Speak into the microphone.

Telephone Call Perform one of the following actions:
● To receive call, press Call Response.
● To talk, press and hold the PTT button.
● To listen, release the PTT button.

7.3

Making Priority Dispatch Calls
The Priority Dispatch feature allows you to call the dispatcher on a different talkgroup when a talkgroup is
congested. This talkgroup is called the Priority Talkgroup. Each trunking talkgroup can have an assigned
Priority Talkgroup. Priority Dispatch is not available in Emergency operations. The Scan feature is suspended
when Priority Dispatch is initiated.

Prerequisites: The dispatch console that supports this feature must be programmed to use this feature. For
more information, contact your system administrator.

Procedure:
1. Press the programmed Priority Dispatch button.

A tone sounds, and the radio enters Priority Dispatch mode. The radio exits this mode when the
Priority Dispatch Time Out Timer expires.

2. Before the Priority Dispatch Time Out Timer expires, press and hold the PTT button to transmit.
The display shows the Priority Talkgroup alias.

3. To listen, release the PTT button.
The radio exits Priority Dispatch mode, return to its original talkgroup, and displays the home channel
alias.
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Chapter 8

Emergency Operation
The Emergency feature is used to indicate a critical situation. An emergency signal overrides any other
communication over the selected channel.
Your radio supports the following Emergency modes:
● Emergency Alarm
● Emergency Call
● Emergency Alarm with Emergency Call
Only one Emergency mode can be assigned to the Top (Orange) button.
Your radio is also programmed to operate in one of the following conditions:
Tactical/Non-Revert

The radio sends an emergency alarm and/or makes an emergency call on the current channel.
Non-Tactical/Revert for Conventional System

The radio reverts to the programmed emergency channel to send an alarm and/or make an emergency
call.

Non-Tactical/Revert for Trunking System
The radio reverts to the programmed emergency talkgroup (trunking system) or channel (conventional
system) to send an alarm and/or make an emergency call.

Fall Alert (Man Down) is an alternate way to activate the Emergency feature.
For more information, contact your system administrator.

8.1

Special Considerations for Emergency Operation
The following scenarios apply during Emergency operation:

Table 11: Emergency Operation Scenarios

Scenario Outcome

If you press the Top (Orange) button while in a
channel that has no Emergency capability.

A low-pitched tone sounds.

If you change to a channel/mode with no Emergen-
cy capability while in Emergency operation.

A continuous low-pitched tone sounds until you se-
lect a valid Emergency channel/mode or until you
disable the Emergency operation.

If you change to a channel/mode with Emergency
capability while in Emergency operation.

The Emergency Alarm and/or Emergency Call con-
tinues on the new channel/mode.

If the radio is out-of-range of the system or the
emergency alarm is not acknowledged.

A tone sounds and the display shows No ac-
knowledge.

MN009363A01-AE
Chapter 8:  Emergency Operation

51



8.2

Sending Emergency Alarms
Procedure:

Press the programmed Top (Orange) button.
Result:
Your radio shows the following indications:
● A positive indicator tone sounds.
● The red LED blinks.
● The display shows Emergency, and the current zone or channel.

When you receive acknowledgement from the dispatcher, your radio shows the following indications:
● Four tone sounds.
● The alarm stops.
● The display shows Ack received.

● Your radio exits Emergency Alarm mode.

8.3

Sending Emergency Alarms with Emergency Calls
Procedure:

1. Press the programmed Top (Orange) button.

If successful, your radio shows the following indications:
● A positive indicator tone sounds.
● The red LED blinks momentarily.
● The display shows Emergency, and the current zone or channel.

When the radio exits Emergency Alarm and enters the Emergency Call state, your radio shows one of
the following indications:
● You receive the dispatcher acknowledgment. The display shows Ack received.

● You receive no acknowledgment. The display shows No acknowledge.

If unsuccessful, a negative indicator tone sounds and your radio rejects to launch emergency mode.

2. To call, press and hold the PTT button.
3. To listen, release the PTT button.

8.4

Exiting Emergency Operation
If an Emergency operation is triggered on your radio, the dispatch console, or radios configured as
Supervisor can exit the Emergency operation. Radios configured as Supervisor can cancel emergency mode
of other radios. The dispatch console must be programmed to use this feature. For more information, contact
your system administrator.
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Procedure:
● To exit the emergency operation, press and hold the programmed Top (Orange) button.
● To exit the emergency operation as supervisor (Trunking only), use one of the following options:

Option Actions

Exiting Emergency operation initiated by the
Supervisor

Perform one of the following actions:
○ Press and hold the Top (Orange) button.
○ Press and hold the 1-Dot Programmable

button. Press the Top (Orange) button.
○ Wait for the console to clear the Emergen-

cy.

NOTE: Your radio supports the following button combinations:
○ Radio 1-Dot Programmable button and Top (Orange) button.
○ Radio 1-Dot Programmable button and accessory Orange button.
○ Radio Top (Orange) button and accessory 1-Dot Button.

8.5

Remote Emergency
The Remote Emergency feature allows you to remotely launch the emergency feature on a target radio.
You can send the Remote Emergency request to radios from recently transmitted or received calls that are
stored. The latest Recent Call List refreshes automatically on your radio.

8.5.1

Sending Remote Emergency to Specific Users
Procedure:

1. Press the programmed Remote Emergency button.
2. Select the required user of the target radio.
3. To send Remote Emergency, press the PTT button or press the Send menu button.

Result:
If the ID of the target radio is valid, your radio displays sending notification and saves the ID as the last
Remote Emergency ID.
If the ID of the target radio is invalid, your radio displays an invalid ID notification.
If your radio is in one of the following states, your radio plays a tone.
● Receive-only Channel
● Transmit Inhibit
● Out of Range
● Imbalance Coverage
If your radio receives acknowledgment, your radio displays a positive notification.
If your radio does not receive acknowledgment from the target radio, your radio displays a negative
notification.
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8.5.2

Sending Remote Emergency by Entering the User ID
Procedure:

1. Press the programmed Remote Emergency button.
2. Press any digit key.
3. Enter the number of the user ID.
4. To send Remote Emergency, press the PTT button or press the Send menu button.

Result:
If the ID of the target radio is valid, your radio displays sending notification and saves the ID as the last
Remote Emergency ID.
If the ID of the target radio is invalid, your radio displays an invalid ID notification.
If your radio is in one of the following states, your radio plays a tone.
● Receive-only Channel
● Transmit Inhibit
● Out of Range
● Imbalance Coverage
If your radio receives acknowledgment, your radio displays a positive notification.
If your radio does not receive acknowledgment from the target radio, your radio displays a negative
notification.

8.5.3

Manually Refreshing the Remote Emergency List
Procedure:

1. Press the programmed Remote Emergency button.
2. To refresh the remote emergency list, press Rfsh.

Result: Your radio displays List refreshed followed by the updated remote emergency list..

8.5.4

Receiving Remote Emergency
The remote emergency will only be launched if your radio has the emergency enabled. The receiving radio
displays Emergency.

Procedure:
To exit the emergency operation, press and hold the programmed Top (Orange) button.

8.5.5

Filtering Remote Emergency Contacts
This feature allows you to filter contacts.

Procedure:
1. Press the programmed Remote Emergency button.
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2. Press the Fltr menu item button.
Result:
Your radio displays the filtered call list.

8.6

Emergency Keep-Alive
This feature prevents the radio from being turned off when it is in Emergency mode. If this feature is enabled,
you are required to exit Emergency mode before turning off your radio.

8.7

Emergency Beacon
When the radio is in Emergency mode, the Emergency Beacon feature transmits Bluetooth Low Energy
(BTLE) signals and other Emergency information to nearby radios.
Contact your system administrator for more information.

8.7.1

Sending Emergency Beacons
The following method allows you to transmit the beacon.

Procedure:
Press the programmed Top (Orange) button.

8.7.2

Receiving Emergency Beacons
When you receive emergency beacon, the display shows Beacon Received, the transmitting radio ID, or
alias.

Procedure:
Perform one of the following actions:
● To view the beacon list, press Details.
● To dismiss the beacon, press Dismiss.

NOTE: If there are multiple beacons, the radio displays the recent beacon received.

8.7.3

Viewing Received Emergency Beacon
Procedure:

Press the Bcon menu item.
NOTE: The received beacons are removed from the list after four minutes.
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Chapter 9

Fireground
The portable Fireground Communications System is designed for deployment at an incident scene.
It consists of central components that provide on-scene and in building radio coverage, and enhanced
personnel accountability and monitoring:
● Your APX portable radios
● Incident Management Software
● Command Terminal
● Radio Frequency (RF) Modem (Conventional Only)
● Control Channel Radio (Trunking)
● Optional Data Radio (Trunking)
● Accountability Server (Trunking)
● DVRS (Optional)
If you have a critical situation, you can press the Emergency button, which activates an alarm on the Incident
Management Software at the command terminal.
The command terminal receives the following status updates from your radio:
● Turning the radio on and off
● Automatic response to Polling
● Response to Evacuation commands
● Pressing the PTT button to make voice transmission
● Sending an Emergency Alarm and Call
● Entering or exiting a Trunking Talkgroup

9.1

Entering Fireground Zone Channel (Conventional)
Prerequisites:

NOTE: If you are entering Fireground Trunking Talkgroup, ensure that the Fireground Trunking
Talkgroup is selected.

Procedure:
1. Cycle power your radio.
2. Press the Fireground Zone Channel menu item.
3. Listen for a transmission.
4. To call, press and hold the PTT button.
5. To listen, release the PTT button.
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9.2

Responding to Evacuation Indicator
When you receive an Evacuation Indicator, the radio shows the following indications:
● A tone sounds.
● The display shows the configurable programmed alert text and intelligent lighting.

Procedure:
To respond, perform one of the following actions:
● Press the 3-Dot Programmable button.
● If the radio is connected to the Remote Speaker Microphone (RSM), press the 1-Dot button on the

RSM.
● Press the PTT button.

NOTE: The PTT button must be configured in Customer Programming Software (CPS) to enable
this function.

Result: The radio cancels the indications, a tone sounds, and the radio sends an acknowledgment to the
command terminal.

9.3

Sending Evacuation Tone
Procedure:

1. Press and hold the PTT button.
2. Press the Emergency button.

Result: A tone sounds when the Emergency button is released. The tone sounds in all radios within the
talkgroup until the PTT button is released.

NOTE: Radio does not transmit evacuation tone if the radio is in secure mode.
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Chapter 10

Tactical Public Safety (Conventional
Only)
Tactical Public Safety (TPS) enables the member of a group to identify the start and the end of a transmission
by displaying the caller name or ID on the radio display.

10.1

Using TPS Normal Transmission
Procedure:

In the TPS Zone Channel, perform one of the following actions:
● To talk, press and hold the PTT button.
● To listen, release the PTT button.
● Receive and listen to the call.

Result: The display shows the caller name or ID.

10.2

Using TPS Emergency Transmission
Procedure:

1. Press the programmed Top (Orange) button.
The Emergency Beacon tone sounds.

2. To call, press and hold the PTT button.
3. To listen, release the PTT button.

The Emergency Call De-Key Sidetone sounds. After a short pause, the Emergency Beacon tone
sounds.

4. To exit or cancel the Emergency mode, press and hold the programmed Top (Orange) button.
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Chapter 11

Man Down (Fall Alert)
Man Down (Fall Alert) is a supporting feature of the Emergency operation. The Emergency feature must be
programmed for Man Down (Fall Alert) to operate.
Your radio activates the Man Down (Fall Alert) feature when it achieves or exceeds a tilt angle threshold or a
combination of the angle threshold and radio motion below the motion sensitivity level. The radio must stay in
this condition for a programmed period before the Emergency Alarm or Call is activated.

NOTE: Because Man Down (Fall Alert) may be triggered accidentally, consider the following scenarios
when using your radio:
● If the radio is programmed to a horizontal position only, it must be worn in a vertical position.
● If the radio is programmed with the Man Down (Fall Alert) feature, turn off the radio when charging it

with a wall-mounted charger.
● When you dismiss Man Down (Fall Alert) and keep the radio horizontal, no emergency will be sent

and no further Man Down (Fall Alert) notification will occur until the device is rotated back to normal
(portrait) mode.

11.1

Radio Alerts When Man Down (Fall Alert) is
Triggered
When Man Down (Fall Alert) is triggered, your radio plays an alert tone and the display shows Man Down. If
the radio is programmed for Surveillance Mode, it inhibits all tones and lights including the Man Down (Fall
Alert) tones.

Man Down (Fall Alert) Enhanced
Your radio also supports Man Down (Fall Alert) Enhanced where it plays an alert tone for a preprogrammed
period. This tone is louder than the preprogrammed minimum level or the current level of the speaker and it
acts as a beacon that helps to find the radio.

NOTE: The radio plays this alert tone even in Surveillance Mode.

When the alert tone is active, changing to another channel with a different setup triggers a different response
from the radio:
● The alert tone is inhibited when you change to a channel without Emergency feature.
● The alert tone is inhibited when you change to a channel with Emergency but no Man Down (Fall Alert)

feature.
● The current alert tone is inhibited and is replaced with a different alert tone when you change to a channel

with Emergency feature and a different Man Down (Fall Alert) configuration.
● The alert tone continues when you change to a channel with Emergency and similar Man Down (Fall

Alert) configuration.
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11.2

Testing Man Down (Fall Alert)
Prerequisites: Ensure that Man Down (Fall Alert) feature is configured in your radio.

Procedure:
1. Turn on the radio, and place it in a vertical position for at least 5 seconds.
2. Lay the radio down in a horizontal position.

Result: Your radio shows the following indications:
● Alert tone
● The display shows Man-Down.

Postrequisites: If Man Down (Fall Alert) is configured but the condition does not trigger the activation of the
feature, send the radio to a qualified technician.

11.3

Exiting Man Down (Fall Alert)
Procedure:

To exit Man Down (Fall Alert) mode, press Clr.

11.4

Reinitiating Man Down (Fall Alert)
Procedure:

To reinitiate Man Down (Fall Alert) after exiting Emergency Operation, perform one of the following
actions:
● Return the radio to a vertical position.
● If motion sensitivity is enabled, shake the radio.
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Chapter 12

Secure Operations
Secure radio operation provides the highest commercially available level of voice security on both trunked
and conventional channels.
By default, the radio automatically enters the encrypted environment without having to manually select or
clear the secure transmission.

12.1

Switching Between Secure and Clear
Transmission
Procedure:

1. To select Secure Transmission, press the programmed Secure/Clear side button.
When you press the PTT button and the selected channel is programmed for clear only operation,
your radio shows the following indications.
● A negative tone sounds.
● The display shows Clear TX only.

The radio does not transmit until you set the Secure/Clear side button to clear mode.

2. To select Clear Transmission, press the programmed Secure/Clear side button.
When you press the PTT button and the selected channel is programmed for secure only operation,
your radio shows the following indications.
● A negative tone sounds.
● The display shows Secure TX only.

The radio does not transmit until you set the Secure/Clear side button to secure mode.
NOTE: If the Ignore Secure/Clear Switch When Strapped field is enabled, the radio transmits
without displaying any messages in the strapped mode operation. The Secure/Clear side button
is only applicable when the radio is transmitting.

12.2

Encryption
This chapter explains the encryption feature on your radio.

NOTE: Contact your system administrator for more information.

12.2.1

Multikey Feature
This feature allows the radio to be equipped with different encryption keys.
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There are two types of encryption keys:
Conventional Multikey

The encryption keys are strapped on a one-per-channel basis, through CPS. In addition, you can have
operator-selectable keys, operator-selectable keysets, and operator-selectable key erasure. If talkgroups
are enabled in conventional, then the encryption keys are strapped to the talkgroups.

Trunked Multikey
If both conventional and trunked applications are applied, strap the encryption keys for trunking on a
per-talkgroup, or announcement-group basis. Also, a different key can be strapped to other features such
as dynamic regrouping, failsoft, or emergency talkgroup. You can have operator-selectable key erasure.

12.2.2

MDC OTAR (Conventional Only)
This feature allows you to view or define the Motorola Data Communications (MDC) Over-the-Air Rekeying
(OTAR) features. It is applied only when operating in secure encrypted mode. In addition to Rekey Requests,
OTAR transmissions include Delayed Acknowledgments, and Power-up Acknowledgments.
Some of the selected options require configuration at the Key Management Controller (KMC) site to work
properly.

NOTE: This feature must be programmed by a qualified radio technician.

12.2.3

Infinite UKEK Retention
This feature enables Unique Key Encryption Key (UKEK) to be permanently stored in the radio even when all
the encryption keys are erased. Without this UKEK key, the radio cannot be rekeyed over the air. The Infinite
UKEK Retention settings can be different for each secure profile.

NOTE: This feature must be programmed by a qualified radio technician.

12.2.4

Hear Clear
Hear-Clear is a noise reduction system which consists of Companding and Random FM Noise Canceller.
Companding

Reduces the channel noise, such as OTA transmission that is predominantly present in UHF2 and 900
MHz channel with the following features.
Compressor
Reduces the background noise flow and the speech signal at transmitting radio.
Expander
Expands the speech while the noise flow remains the same at receiving radio.

Random FM Noise Canceller (Flutter Fighter)
Reduces the unwanted effects of random FM noise pulses caused by channel fading under high Signal-
to-Noise (S/N) conditions such as in a moving transportation. The fading effects, heard as audio pops and
clicks, are canceled without affecting the desired audio signal.
The Random FM Noise Canceller operates only in receive mode.

NOTE: This feature must be preprogrammed by a qualified radio technician. Check with your dealer or
system administrator for more information.
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12.2.5

Loading Encryption Keys
Procedure:

1. Attach the Key Variable Loader (KVL) to your radio.
The display shows Keyloading. All other radio functions are locked, except power down, backlight,
and volume.

NOTE: If the Multisystem Over-the-Air Rekeying feature is in use, the ASTRO profile name is
displayed below Keyloading.

2. Select the required keys and press Load on the KVL.
Result: The KVL indicates that key load is successful.

12.2.6

Selecting Encryption Keys
Procedure:

1. Press the Key menu item.
2. Select the required key or enter the key number.
3. To save the new key, press Sel.

If the selected key is not allowed, a tone sounds and the display shows Illegal key. If the selected
key is erased, a tone sounds and the display shows Key fail.

12.2.7

Selecting Keysets
This feature allows you to select one or a group of encryption keys from the available keys stored in the radio.

Procedure:
1. Press the Kset menu item.
2. Select the required key.
3. To save the new keysets, press Sel.

12.2.8

Erasing Encryption Keys
Procedure:

1. Select Eras.
2. Navigate to the encryption key or use the keypad to enter the key.
3. Select Optn.
4. Select the required option and select Sel.
5. To erase single key from the radio, select Erase single keys? → Yes.
6. To erase all keys from the radio, select Erase all key? → Yes.
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12.2.9

Requesting Over-the-Air Rekey
If the Multi-system Over-the-Air Rekeying feature is in use, the rekey request is only for the current selected
secure profile.

Prerequisites: Ensure that the Unique Key Encryption Key (UKEK) or Unique Shadow Key (USK) is loaded
into the radio with the Key Variable Loader (KVL) before the rekey request can be sent. Refer to your local
key management supervisor for more information.

Procedure:
1. Press the Reky menu item.
2. Send the rekey request by pressing the PTT button.
3. To exit the feature and transmit in normal mode, press one of the following buttons:

● PTT button
● Home button
● Top (Orange) button
If the rekey operation fails, a negative tone sounds and the display shows Rekey fail.

NOTE: The rekey operation failure indicates that your radio does not contain the UKEK or USK.
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Chapter 13

Scan
This feature allows you to monitor traffic on different channels by scanning a programmed list of channels.
Scanning is halted if you initiate a call and resumes when the call has ended.

13.1

Turning Scan On or Off
Procedure:

Turn scan on or off by pressing the Scan menu item.

If the scan is enabled, the display shows Scan On and the Scan status icon.

If the scan is disabled, the display shows Scan Off.

13.2

Making Dynamic Priority Change (Conventional
Scan Only)
While the radio is scanning, the dynamic priority change feature allows you to temporarily change any
channel in a scan list (except for the Priority-One channel) to the Priority-Two channel. This change remains
in effect until scan is turned off. Scan then reverts to the default setting.

Procedure:
When the radio locks onto the channel designated as the new Priority-Two channel, press the
programmed Dynamic Priority button.

Result: The radio continues scanning the remaining channels in the list.

13.3

Deleting Nuisance Channel
Procedure:

1. Identify the nuisance channel.
2. Press the Nuis menu item.

Result: The radio continues scanning the remaining channels in the list.
NOTE: This feature is not applicable for priority channels, or the designated transmit channel.
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13.4

Restoring Nuisance Channels
Procedure:

To restore the deleted nuisance channel, perform one of the following actions:
● Stop and restart a scan.
● Mode change to another channel, and return to the original channel.
● Turn off the radio and then turn it on again.
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Chapter 14

Scan Lists
Scan lists are created and assigned to individual channels or groups. Your radio scans for voice activity by
cycling through the channel or group. The sequence of scan is as specified in the scan list for the current
channel or group.
Your radio supports different types of Scan Lists:
● Conventional Scan List
● Talkgroup Scan List
● Trunking Priority Monitor Scan List
Refer to a qualified radio technician for the maximum number of Scan Lists to be programmed in your radio.

14.1

Intelligent Priority Scan
This feature allows you to add or delete conventional channels and trunking talkgroups from multiple systems
into the priority scan lists.
When the radio locks onto a channel in the Intelligent Priority Scan list, the radio scans for higher priority
member within the same Trunking or Conventional system.

14.2

Managing the Scan List
Procedure:

1. Press the SCNL menu item.
2. Manage the scan list by using the following options:

Option Actions

Viewing the scan list At the Edit Scan screen, view the scan list by scrolling
through the list.

Adding a channel into the scan list At the Edit Scan screen, press Sel.
The currently highlighted channel is added into the scan
list.

Assigning priority to the scan list a. At the Edit Scan screen, scroll to the required chan-
nel, and press Sel.

b. Scroll to the required priority, and press Sel.

Removing a channel from the scan
list

a. At the Edit Scan screen, scroll to the required chan-
nel.

b. Press Del.
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Option Actions

Recalling the next channel in the
scan list

At the Edit Scan screen, press Rcl.
The display auto scrolls to the next channel in the scan
list.
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Chapter 15

Connectivity
This section explains the management of connections between your radio and a variety of networks and
other devices.

15.1

SmartConnect
Before switching broadband connections, your radio compares the relative signal strength of the various
broadband connection types to one another, as well as Land Mobile Radio (LMR).
Your radio remains or returns to LMR connection when the other broadband connections fall below the quality
threshold. A radio operating on a lower priority broadband connection returns to the higher priority or quality
connection while idle on SmartConnect.

Your radio displays the SmartConnect capable icon  on the SmartConnect enabled channel.

When connected to an available network, your radio displays SmartConnect connection icon .
NOTE:
This feature must be programmed by a qualified radio technician. For more information, contact your
system administrator.

15.2

Wi-Fi
You can connect your radio to a Wi-Fi network for wireless programming. Your service administrator
preprograms the Wi-Fi Service Set Identifier (SSID) or network name that your radio can connect to. This
feature is enabled by default on your radio.

NOTE: Channel 12 and 13 are enabled for Wi-Fi for all countries except US and Canada.

15.3

Bluetooth®
This feature allows your radio to extend its functionality by connecting to external proprietary Motorola
Solutions accessories. Use Motorola Solutions proprietary Mission Critical Wireless (MCW) devices with APX
radios during Mission Critical operations. Other Bluetooth devices may or may not meet the mission critical
standard.
Your radio supports the following Bluetooth enabled devices or profiles:
● Headset (HSP)
● Dial Up Networking (DUN)
● Personal Area Networking (PAN)
● Serial Port (SPP)
● General Attribute Profile (GATT)
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15.3.1

Turning Bluetooth On or Off
Procedure:

1. Press the BT menu item.
2. Select Status.
3. Perform one of the following actions:

● To turn on Bluetooth, press On.
● To turn off Bluetooth, press Off.

15.3.2

Searching and Pairing the Bluetooth Device
Prerequisites: Ensure that the Bluetooth on your device is turned on and set to Discoverable in order to
enable your radio to detect your device in Bluetooth.

Procedure:
1. Press the BT menu item.
2. Press Search Devices → On.
3. To pair with an available device, select the required device and press Sel.

Result: The radio pairs to the device.

15.3.3

Turning Bluetooth Audio On or Off
NOTE:
Bluetooth audio routing can be configured in the Customer Programming Software (CPS) to route the
audio to the radio internal speaker. The audio routes to the radio speaker if the radio Remote Speaker
Microphone (RSM) is not connected. For more information, contact your system administrator.

Procedure:
1. Press the BT menu item.
2. Select Bluetooth spkr.
3. Perform one of the following actions:

● To turn on Bluetooth audio, press On.
● To turn off Bluetooth audio, press Off.

15.3.4

Viewing and Clearing the Bluetooth Enabled Device
Information
Procedure:

1. Press the BT menu item.
2. Select Devices and press Sel.

MN009363A01-AE
Chapter 15:  Connectivity

70



3. To view the status of devices that are paired or connected, scroll through the list of <Device
Friendly Name>.

If there are no active Bluetooth devices paired or connected, the display shows No devices.

4. To clear a device from the list, select the required device and press Clr → Yes.

15.4

ASTRO 25 (P25) Programming Over Project 25
(POP25)
Also known as Over-the-Air Programming, this feature allows configuration data and firmware to be upgraded
to your radio over-the-air. Full use of the radio is retained during the data transfer without interrupting
communication.
If the upgrade happens on the ASTRO 25 and ASTRO Conventional systems, the upgrade pauses to give
priorities to voice call, and continues after the voice call ended. If the upgrade happens on a Wi-Fi network,
the upgrade process runs concurrently with voice calls.
Once a configuration upgrade is downloaded to your radio, you can install new changes immediately, or delay
changes to be installed on the radio when it is being powered up.
Your radio can also be configured to allow you to accept or reject an upgrade.

15.4.1

Responding to Upgrade Notifications
The display shows Upgrade? and a tone sounds every 30 seconds until you accept, delay, or reject the
request.

NOTE: Do not remove the power cable or turn off the radio during the firmware upgrade process. If your
radio has problems upgrading over-the-air, consult a qualified technician for details.

Procedure:
Respond by performing one of the following actions:
● To accept the upgrade request, press Acpt.
● To delay the upgrade request, press Dlay.
● To reject the upgrade request, press Rej.

Result: One of the following scenarios occurs:
● If you choose to accept, the display shows Programming Dont power off. The radio resets to install

the upgrade.
NOTE: The radio cannot be used while the upgrade is being installed. You must ensure to accept
the upgrade at a convenient time.

● If you choose to delay, a configuration data upgrade is installed automatically at the next power up. In the
case of a firmware upgrade, the radio prompts Upgrade? again at the next power up.

● If you choose to reject, the display shows Upg Aborted. The radio continues to function with the current
configuration until it gets reprogrammed.
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Chapter 16

Location
The Global Navigation Satellite System (GNSS) in the radio integrates information from the Global
Positioning System (GPS) to determine the approximate geographical location of your radio.

NOTE: The Location feature is addressed as Global Positioning System (GPS) across the manual as
the naming convention of the buttons and strings remain the same as the legacy feature of GPS.

The availability and accuracy of this location information and the calculation duration can vary depending on
the environment in which you are using the GPS feature. For example, GPS location fixes are difficult to
obtain indoors, in covered locations, between high buildings, or in situations where you have not established
a clear broad view of the sky.
If adequate signals from multiple satellites are available, your GPS feature only provides an approximate
location, usually within 10 meters from your actual location, but sometimes farther away.
Sometimes, the GPS feature cannot complete a location calculation successfully. You will then see a
message indicating that your radio cannot connect to enough visible satellites.
To maximize the ability of your radio to determine a fix, take note of the following guidelines:
● For your initial fix, hold the radio in the face position.
● Stay in the open as the GPS feature works best when there is nothing between your radio and the open

sky.

16.1

Turning Location On or Off
Procedure:

1. Press the Loc menu item.
2. Perform one of the following actions:

● To turn on Location, press Optn → Turn On GPS → Sel.
● To turn off Location, press Optn → Turn Off GPS → Sel.

16.2

Accessing Location
Procedure:

1. Press the Loc menu item.
2. Press Optn → Turn On GPS → Sel.
3. To check the last successful location fix, select the longitude, time, and date.
4. To access the current location, press Rfsh.
5. To return to the Home screen, press Exit.

Result:
If the radio successfully obtains the current location, the display shows the following information:
● Current Location
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● UTC (Zulu) Time
● Date

NOTE: If the location signal is present, the location coordinates are automatically updated every five
seconds. If the radio fails to obtain the current location, the display shows No service and returns to
the previous screen.

16.3

Selecting Location Formats
The Location Format feature allows you to select different display formats of the Global Positioning System
(GPS) location.
The following GPS location formats are available:
● Lat/Long(DD)
● Lat/Long(DDM)
● Lat/Long(DMS)
● UTM/UCS
● SLD99
● MGRS

NOTE: When you send your location to another radio, the receiving radio displays the location in its
selected format.

Prerequisites:

Procedure:
1. Press the Loc menu item.
2. Press Optn → Loc Format → Sel.
3. Select the required location format.

Result: The display shows the location with the selected format.
NOTE:
If the SLD99 format is selected and the range is invalid, the display shows ––––––––––– on the
location. This situation occurs when you use the radio outside of Sri Lanka.
To correct this situation, switch the location display format to other GPS options such as DDM, DMS,
UTM/UCS, or MGRS.

16.4

Managing Waypoints
Prerequisites: Ensure that your radio displays the current location.

Procedure:
1. Press the Optn menu item.
2. Press Waypoints → Sel.
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3. Manage waypoints by using the following options:

Option Actions

Viewing waypoints a. Scroll to the required waypoint from the list.
b. Press Optn → View → Sel.
The display shows the following information of the selec-
ted waypoint:
● Military Grid Reference System (MGRS) or, latitude

and longitude location
● Time
● Date

Deleting a waypoint a. Scroll to the required waypoint from the list.
b. Press Optn → Delete → Sel → Yes.
The display shows a positive notification.

Deleting all waypoints a. Scroll to any waypoint from the list.
b. Press Optn → Delete All → Sel → Yes.
The display shows a positive notification.

NOTE: You cannot delete any of the program-
med waypoints.

4. Return to the Home Screen by pressing the Home button.

16.5

Location Feature in Emergency Mode
When the Emergency feature is activated, the radio exits the Location menu and returns to the Home screen.
You can view the channel that triggers the emergency signal.
You can reenter the Location menu while still in Emergency mode as long as Silent Emergency is not
activated.
If you have disabled the Location feature on your radio, it automatically turns back on when Emergency mode
is activated.
If there is a solid location signal during Emergency operation, the current location and the location information
received is saved as Emergency and Last Known Location respectively.

16.6

Peer-Location on the Display (ASTRO
Conventional)
This feature is only available for radio-to-radio voice transmissions, dispatch call, and selective call.
The transmitting radio and receiving radio must be configured to enable the sending and receiving of the
Global Positioning System (GPS) coordinates.

NOTE: If the receiving radio is operating in a Mixed Mode channel and the voice transmission is from
the conventional ASTRO system, the radio can only receive the peer-location coordinates.
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This feature is operable in a Scan Active channel, or Scan Talkback channel.
After receiving a voice transmission with GPS coordinates enabled on the receiving radio, the display shows
the available full location, or short location coordinates.
Full location coordinates

● PTT ID (optional)
● Longitude and latitude
● Relative distance or direction

Short location coordinates
● PTT ID (optional)
● Longitude and latitude

NOTE:
If the transmitting radio is stale at the location after a period of time, the receiving radio display shows
the last known location. If the transmitting radio does not have GPS, or the receiving radio could not
decode the GPS signal of the received signal, the receiving radio display shows the location as
unknown.

16.7

MGRS Coordinates
Military Grid Reference System (MGRS) can only be enabled through Customer Programming Software
(CPS) configuration. When the MGRS coordinate is enabled, all location coordinates are displayed in the
MGRS format, including the editable locations in GPS.
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Chapter 17

Mission Critical Geofence (ASTRO 25
Trunking)
This feature allows the radio to use the Global Positioning System (GPS) receiver to determine its location
at frequent intervals and evaluate if the radio is within the Geofence area in real time. Geofence is a virtual
perimeter based on the GPS to define a geographical area on earth.
When the radio enters the predefined Geofence area, your radio receives the Dynamic Regroup command
from the system and immediately connects to a Dynamic Regroup talkgroup. The radio display shows
the new selected Dynamic Regrouped talkgroup with green intelligent light for your attention. Voice
Announcement is also available to support this feature.
Any new text messages received at Geofence is displayed immediately on the radio display.

NOTE:
If the radio is set up in Digital Vehicular Repeater System (DVRS), only mobile radio is supported for
this feature.
The user navigation for this feature is not available for this model.

17.1

Entry to the Geofence Area
The Voice Announcement and Text Messaging Service (TMS) display in this feature are optional. These
features must be configured to enable you to hear, and see these indicators.
When the radio enters a Geofence area, the radio immediately sends a message ACK back to the system.

The radio searches the current zone for the channel with same talkgroup assigned as the Dynamic Talkgroup
and also with same system ID of current trunk system. Once matched, the radio display shows the first
matched and connected channel alias.
If there is no channel with matching Talkgroup ID and trunk system ID, the radio display shows the channel
alias of <DYNAMIC talkgroup>.

Once the radio is connected, you hear a dynamic regroup tone. The radio display shows <DYNAMIC
channel>. The radio display shows the green intelligent backlight, and you hear a Voice Announcement.

NOTE:
When the radio loses the Global Positioning System (GPS) signal, the GPS icon blinks and the radio
sounds two high-pitched tones repetitively to indicate that the GPS has failed to operate. The radio
display shows the red intelligent light.
If the first matched channel is not configured with Voice Announcement, no Voice Announcement is
played.

The system sends a message to your radio. The radio display shows a direct text message content without
any user operation. This message indicates that you are currently present in a Geofence area. This TMS
remains open on the display until you press exit or home to exit this screen.

NOTE: If there is another incoming text message before you exit the previous message, the message
screen is refreshed to show the latest message.
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When the radio exits the Geofence area, your radio reverts to original channel or newly assigned talkgroup.
The radio display shows the new channel together with Voice Announcement to indicate the changes. Voice
Announcement of the new channel only works if that channel is configured with Voice Announcement.

17.2

Entry to Mission Critical Geofence
When the radio enters the predefined Geofence area, the radio displays <Geofence Alias>. The radio
display also shows the intelligent backlight, and you hear a Voice Announcement. Zone and channel alias of
the Geofence area is displayed.
If the radio is set to manual, you can choose either to proceed with zone and channel change, or cancel the
change.
The radio then connects to the designated talkgroup. The radio displays the talkgroup alias and dynamic
regroup tone sounds. The level changes for transmit power and, your radio shows a direct text message
content without any user operation.

NOTE:
The availability of the Voice Announcement (VA), Text Messaging Service (TMS) display, Intelligent
Backlight, and Transmit Power Level alerts depend on your radio configuration. The VA can be
programmed to alert continuously, or momentarily.
If Site Selectable Alert (SSA) is enabled, the radio mutes any alert that is received when entering the
Geofence area, and unmutes when exiting.

17.3

Exit from Mission Critical Geofence
When the radio exits the Geofence area, the radio reverts to the original transmit power level, intelligent
lighting, channel, or newly assigned talkgroup. Voice announcement (VA) is canceled or you hear a
programmed VA tone. The radio displays the new channel, and a message is received to indicate the
changes.
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Chapter 18

Contacts
This feature provides address-book capabilities on your radio. Each entry corresponds to an alias (name) and
ID (number) that you use to initiate a call. Contact entries are alphabetically sorted according to the entry
alias.
Each entry, depending on context (conventional, trunking, or phone), associates with one to five IDs
according to the following types of calls:
● Phone Call
● Private Call
● Selective Call
● Call Alert
Each entry within Contacts contains the following information:
● Call Alias (Name)
● Call ID (Number)
● Call Type (Icon)
● WACN ID (ASTRO 25 Trunking IDs only)
● System ID
Your radio also supports a maximum of 50 call lists. Each list can store up to 100 IDs.

NOTE: Your radio is programmed with a few contacts per Call Lists. Check with your dealer or system
administrator for more information.

18.1

Viewing Contact Details
Procedure:

1. Press the Cnts menu item.
2. Select the required contact.
3. Press Optn → View → Sel.
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Chapter 19

Recent Calls
Recent call menu allows you to view the recent incoming and outgoing call information.
You can view the information of the following type of calls:
● Call Alert
● Selective Call
● Private Call
● Phone Call (Outgoing Only)
● Emergency Call (Incoming Only)

NOTE: The Log Dispatch Calls Enable field need to be enabled in Customer Programming Software
(CPS) for your radio to log the dispatch call.

19.1

Viewing Recent Calls
Procedure:

1. Press the Rcnt menu item.
2. To view recent Emergency Calls, press Emer.
3. To return to all recent calls, press All.

19.2

Deleting Calls
This feature allows you to delete calls from the Recent Calls list.

Procedure:
Delete calls by using the following options:

Option Actions

Deleting all calls a. Press Optn.
b. Select Delete Calls.
c. Select All Calls.
d. Press Yes.

Deleting non-emergency calls a. Press Optn.
b. Select Delete Calls.
c. Select Non-Emer Calls.
d. Press Yes.

Result:

MN009363A01-AE
Chapter 19:  Recent Calls

79



When you have successfully deleted all calls, your display shows All calls deleted and the Recent
Calls list is empty.
When you have successfully deleted non-emergency calls, your display shows Non-emer calls deleted
and the Recent Calls list only contains emergency calls.
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Chapter 20

Sending Status
You can send status messages to the dispatcher. A status transmission makes more efficient use of a
channel as compared to a voice transmission.

Procedure:
1. Press the programmed Status button.
2. Select the required status.
3. To send the status, press the PTT button.

Result:
If acknowledgement is received, your radio shows the following indications:
● Four tones sound.
● The display shows Ack received.

If acknowledgement is not received, your radio shows the following indications:
● A tone sounds.
● The display shows No acknowledge.
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Chapter 21

Call Alert Paging
This feature allows your radio to work like a pager.
If other users are away from their radios or if they are unable to hear their radios, you can send them an
individual call alert page. You can also verify if a radio is active on the system.
If there is no answer after the maximum ring time or when you press the PTT button for an Enhanced Private
Call, the radio automatically sends a call alert page.

NOTE: This feature must be programmed by a qualified radio technician.

21.1

Sending Call Alert Page
Prerequisites: Ensure that your radio is programmed to support this feature.

Procedure:
Send a call alert page using one of the following options:

Option Actions

Page Menu a. Press the Page menu item.
b. Press Cnts.
c. To send the page, press the PTT button.

Call Menu a. Press the Call menu item.
b. Press Cnts.
c. Select the ID or alias.
d. To initiate the call, press the PTT button.
If the target radio does not respond after a programmed
period, the display shows Send page?. Press Yes.

Result:
● The display shows Paging...<Number>.

● If the call alert page is sent successfully, your radio shows the following indications:
○ A tone sounds.
○ The display shows Ack received and the radio returns to the Home screen.

● If the call alert page is not acknowledged, your radio shows the following indications:
○ A tone sounds.
○ The display shows No acknowledge.
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21.2

Receiving Call Alert Page
When you receive a Call Alert page, your radio shows the following indications:
● A tone sounds.
● The green LED illuminates.
● The display shows Page received.

Procedure:
Press any button to clear the Call Alert page.
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Chapter 22

Automatic Registration Service
Automatic Registration Service (ARS) provides an automated data application registration for your radio.
When you turn on the radio, the device automatically registers with the server. Data applications within the
fixed network determine the presence of a device on the system and send data to the device.
The ARS consists of the following mode:
● ARS Server Mode (Default mode)
● ARS Non-server Mode

22.1

Selecting ARS Mode
Procedure:

Select the Automatic Registration Service (ARS) Mode by using one of the following options.

Option Actions

Selecting ARS Mode using the Fre-
quency knob

Rotate the programmed Channel Selector knob when the
radio displays the required zone.

Selecting ARS Mode from the menu a. Press the Chan menu item.
b. Select the required channel or mode and press Sel.

Result:
The display shows the User Login Indicator icon, the zone, and the ARS server channel mode.

NOTE: If the selected channel or mode is not programmed, the display shows Unprogrammed.
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Chapter 23

User Login Feature
This feature allows you to take on a friendly username such as Text Messaging Service (TMS).
You can still send text messages without logging in as a user. The user login feature only enables the
recipient of your message to identify you as the sender by assigning a username to your message. This
feature is only applicable for Land Mobile Radio (LMR) Messaging.

NOTE: A predefined username that is set more than the maximum allowed characters is an invalid
name.

23.1

Logging In or Out of the User Login Feature

Logging In the User Login Feature
Procedure:

1. Press the User menu item.
2. Scroll to the predefined user name that is required.
3. Select the predefined user name by pressing Logn.
4. To cancel the login process and return to the initial user login screen, press Back.

Result:
If the login process is successful, the radio shows the following indications:
● The display shows the User Login Indicator (IP Packet Data) icon.
● The display shows a positive notice.
If the username is invalid or the login process is unsuccessful, the radio shows the following indications:
● The display shows a blinking User Login Indicator (IP Packet Data) icon.
● The display shows a negative notice.
In the non-Automatic Registration Service (ARS) Mode, the display shows Offline.

Logging Out of the User Login Feature
NOTE: Private data refers to all messages in the text messaging folder. The next user is able to access
the messages if private data is not deleted.

Prerequisites: You are logged on or using Offline Mode.

Procedure:
1. Press the Logt menu item.

One of the following scenarios occurs:
● If the display shows Clear private data?, proceed to the next step.
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● If the Delete Messages On Session End feature is enabled, the radio clears the private data. The
radio then returns to the User Login screen.

2. Perform one of the following actions:
● To clear all your private data, select Yes.

● To keep your private data, select No.
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Chapter 24

Text Messaging Service
Text Messaging Service (TMS) allows you to send and receive messages and run database queries directly
from your radios. The maximum number of characters allowed for a text message is 200 characters.
The types of text messages available are:
● A predefined message (quick text message).
● A query (ASTRO 25 Advanced Messaging Solution).

24.1

TMS Status Icons
Text Messaging Service (TMS) icons appear on the radio display when you send and receive text messages.

Table 12: TMS Status Icons

Icon Name Description

New Message The radio receives a new message. The selected
text message in the inbox is not read.

Inbox Full The inbox is full.

Message Request Reply The message requires a reply. The Request Reply
feature is toggled on before the message is sent.

Urgent Message The message is urgent. The Priority feature is tog-
gled on before the message is sent.

Urgent Message with Request
Reply

The message is urgent and requires a reply. The
Priority and Request Reply feature is toggled on
before the message is sent.

Table 13: TMS Inline Icons

Icon Name Description

Message Read The selected text message in the inbox is read.

Message Unread The selected text message in the inbox is not read.

Message Sent The text message is sent.
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Icon Name Description

Message Unsent The text message cannot be sent.

24.2

Accessing Messages
Quick Text messages are messages that are predefined and usually consist of messages that are used most
frequently. Each Quick Text message has a maximum length of 50 characters. You can select the required
text from the Quick Text.

Procedure:
Access the messaging feature by using the following options.

Option Actions

Sending Quick Text Messages a. Press the TMS menu item.
b. Press Compose → Sel.
c. Scroll to the required predefined message.
d. Press Optn → Send Message → Sel.
e. Scroll to the required address and press Sel.

Viewing Text Messages a. Press the TMS menu item.
b. Press Inbox → Sel.
c. Scroll to the required ID or alias, and press Sel.

Replying to Text Messages a. At the Inbox screen, scroll to the required ID or alias,
and press Sel → Rply.

b. Scroll to the required Quick Text.
c. Send the message by pressing Optn → Send Mes-

sage → Sel.

Deleting a Text Message a. At the Inbox or Sent screen, scroll to the required
message.

b. Press Del.

Deleting All Text Messages a. Press the TMS menu item.
b. Depending on the required folder, press either Inbox

or Sent.
c. Press Clr → Yes.
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Chapter 25

Monitor Feature
The monitor feature ensures that a channel is clear before transmitting.
The lack of static on a digital channel when you switch from analog to digital radios is not an indication that
the radio is malfunctioning. Digital technology quiets the transmission by removing the noise from the signal
and allows only the clear voice or data information to be heard.

25.1

Monitoring Channels
Procedure:

Depending on your preference and programmed functions, monitor channels by using one of the following
options.

Option Actions

Monitoring channels using the Monitor
button

a. Press the programmed Monitor button.
b. If necessary, adjust the Volume Control Knob.
c. To transmit, press and hold the PTT button.
d. To listen, release the PTT button.
The Carrier Squelch indicator appears on the display
when you monitor a channel using the programmed
Monitor button.

Monitoring channels using the selected
zone channel

a. Select the desired zone and channel.
b. Listen for a transmission.
c. If necessary, adjust the Volume Control Knob.
d. To transmit, press and hold the PTT button.
e. To listen, release the PTT button.

25.2

Monitoring Conventional Mode
This feature allows you to monitor channel traffic on conventional channels by defeating the coded squelch.
This way, you can listen to another active user on the channel and you do not take over the conversation of
another user.

Prerequisites: Ensure that your radio is programmed to receive Private-Line® (PL) calls.

Procedure:
1. Press the Monitor button to listen for activity.

The Carrier Squelch indicator appears on the display.

2. Set continuous monitor operation by pressing and holding the Monitor button.
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The duration of the button press is programmable.
3. To return to the original squelch setting, press the Monitor button again or the PTT button.

If you try to transmit on a receive-only channel, you hear an invalid tone until you release the PTT
button.
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Chapter 26

Remote Monitor
This feature allows the system administrator to turn on the microphone of a targeted radio with a subscriber
alias or ID.
When remote monitor feature is activated, the audio transmission can be configured in Customer
Programming Software (CPS) to route the audio to the radio internal microphone, wired Remote Speaker
Microphone (RSM), or Bluetooth wireless microphone.
In life-threatening or critical situations, the system administrator can remotely monitor any audible activity
surrounding the targeted radio.
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Chapter 27

Transmit Inhibit
The Transmit Inhibit feature allows you to stop all transmission including voice and data. The radio can
receive messages but is not able to reply the acknowledgment request of the received message.
This feature is available for APCO 25 Trunking, Type II Trunking, and Conventional operations for all APX
radios.
You can physically control the transmission of the radio especially during operation in hazardous
environments. An environment is considered hazardous if radio transmission could initiate an explosion or
other dangerous reactions.

27.1

Enabling or Disabling Transmit Inhibit
Procedure:

To enable or disable transmit inhibit, press the TxIn menu item.
Result:
If Transmit Inhibit is enabled, your radio shows the following indications:
● A tone sounds.
● The display shows Tx inhibit on.

NOTE: If you press the PTT button, a negative tone sounds.

If Transmit Inhibit is disabled, your radio shows the following indications:
● A tone sounds.
● The display shows Tx inhibit off.

NOTE:
The status of the Transmit Inhibit does not change after the radio powers up.

27.2

Smart PTT (Conventional Only)
Smart PTT is a per-personality, programmable feature used to keep radio users from talking over other radio
conversations. When Smart PTT is enabled in your radio, you cannot transmit on an active channel.
The following table shows the variations of Smart PTT.

Mode Description

Transmit Inhibit on Busy Channel with Carrier You cannot transmit if traffic is detected on the
channel.

Transmit Inhibit on Busy Channel with Wrong
Squelch Code

You cannot transmit on an active channel with a
squelch code or (if secure-equipped) encryption
key other than your own. If the PL code is the
same as yours, the transmission is not prevented.
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Mode Description
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Chapter 28

Dynamic Regrouping (Trunking Only)
This feature allows the dispatcher to temporarily reassign selected radios to a particular channel to
communicate with each other.
When your radio is dynamically regrouped, it receives a dynamic regrouping command and automatically
switches to the dynamically regrouped channel. You hear a tone and the display shows the name of the
dynamically regrouped channel.
When the dispatcher cancels dynamic regrouping, the radio automatically returns to the previous zone and
channel.
If you access a zone or channel that has been reserved as a dynamically regrouped mode for other users,
you hear an invalid tone.

28.1

Classification of Regrouped Radios
The dispatcher can classify regrouped radios into Select Enabled or Select Disabled categories.
Select Enabled

Select-enabled radios are free to change to any available channel, including the dynamic-regrouping
channel, once you have selected the dynamic-regrouping position.

Select Disabled
Select-disabled radios cannot change channels while dynamically regrouped. The radio is forced to
remain on the dynamic-regrouping channel.

The Scan and Private Call features are unavailable when your radio is Select Disabled.

28.2

Requesting a Reprogram (Trunking Only)
You can notify the dispatcher when you want to reprogram a new dynamic regrouping assignment.

Procedure:
To send a reprogram request to the dispatcher, press the Rpgm menu item.

Result:
If the dispatcher acknowledges the reprogram request, your radio shows the following indications:
● Five beeps sound.
● The display shows a positive notification.
Your radio returns to the Home Screen.
If the dispatcher does not acknowledge the reprogram request in six seconds, your radio shows the following
indications:
● A tone sounds.
● The display shows a negative notification.
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Chapter 29

Dynamic Zone Programming
Dynamic Zone Programming (DZP) provides one or more Dynamic Zones to store frequently used channels
for conventional or trunking.

NOTE: Your radio must be programmed for you to use this feature. At least one zone in the radio must
be a nondynamic zone.

29.1

Selecting Channels in the Dynamic Zone
Procedure:

1. Enter a dynamic zone by performing the following actions:
a. Press the Zone menu item.
b. Select <# Dynamic Zone Channels> and press Sel.

# indicates the channel number on the 16-Position Switch that is numbered from 1 to 16.
2. Press the ZnPr menu item.
3. Press Edit → List Selection → Sel.
4. Scroll to the required zone and press Sel.
5. Scroll to the required channel and press Sel.

Result:
The display shows a positive notification and the channel is added to the Dynamic Zone.

29.2

Deleting Channels in the Dynamic Zone
Procedure:

1. Enter a dynamic zone by performing the following actions:
a. Press the Zone menu item.
b. Select <# Dynamic Zone Channels> and press Sel.

# indicates the channel number on the 16-Position Switch that is numbered from 1 to 16.
The radio returns to the Home screen and displays the selected Dynamic Zone Channel.

2. Press the ZnPr menu item.
3. Select the required saved dynamic channel and press Del.
4. To return to the Home screen, press Exit.

Result: The Home screen shows <Dynamic Zone Channels>. If the deleted channel is the home channel,
the Home screen shows <Zone Name>”Blank”.
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Chapter 30

Multiple Private Line
Multiple Private Line (MPL) is a feature that allows user to modify the PL/DPL codes of the current mode by
selecting from a predefined list of codes. For the purpose of accessing different communication sub-groups,
repeaters and others, user no longer need to program multiple channels of the same frequency with different
PL/DPL codes.
The feature supports the following MPL selection Mode:

Table 14: MPL Selection Mode

Selection Mode Description

Dynamic The MPL List selection/functionality is automatically updated (and
active on the radio current channel) as users scroll through the avail-
able MPL List selections.

Static While users are scrolling through the radio available MPL List selec-
tions, MPL functionality does not change until a new MPL List is
manually selected.

30.1

Selecting Multiple Private Line
Prerequisites: Ensure that this feature is enabled in the codeplug and the radio is in Conventional Mode.

Procedure:
1. Perform one of the following actions:

● Press the programmable Multiple Private Line (MPL) Side button.
● Press the MPL menu item.

2. At the Select MPL screen, scroll to the required MPL.
3. Press Sel.
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Chapter 31

Zone-to-Zone Cloning
Zone Cloning clones conventional zones from one radio to another.
You can select the followings zones from a source radio and clone them into a target radio.
● Clone enabled zones
● Dynamic Zones
● Multiple Private Line (MPL)
You can clone the zones by connecting the source radio and target radio with a clone cable. The target radio
must be digital, band, and FCC mandate compatible with the source radio.

NOTE: This feature is applicable for Full Keypad models and Limited Keypad models.

31.1

Cloning Zones
Procedure:

1. Press the Clon menu item.
2. Press Sel.

If successfully connected to the target radio, the radio displays Target radio connected.

3. To accept the source zones selection, press Next.
4. Perform one of the following actions:

● If you select a single source zone, press Sel to select the target zones for cloning.
● If you select multisource zones, the display shows Confirm target and the automatically

selected target zones and source zones mapping.
● If the selected multi-source zones exceed the last clone target zone, the radio displays <#> src

zones unselected, Sel exceed max tgt zone, and Protected tgts not supported
alternatively.

5. To begin cloning, press Clon.
Result:
If cloning is successful, your radio shows the following indications:
● A tone sounds.
● The display shows Clone successful and the source zone alias.

If cloning is unsuccessful, your radio shows the following indications:
● A tone sounds.
● The display shows Clone failed.

NOTE: The target radio enters programming mode during cloning and resets when cloning is
completed.
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Chapter 32

Radio Kill
This feature allows you to render your radio or another radio inoperable if the radio is misplaced or lost. When
a radio is killed, the display turns blank and all functions of the radio are not usable.
The killed radio can only be recovered with a special device. Consult an authorized and qualified technician
for details.

32.1

Using Direct Kill to Kill Your Own Radio
Procedure:

1. Press and hold the 2-Dot Programmable button.
2. Press the Top (Orange) button until the display turns blank and becomes inoperable.
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Chapter 33

Radio Inhibit
This feature allows the system administrator to put a radio into a nonfunctional state when the radio is
missing or in an unknown hand. The radio stays in this state regardless of its power changes.

NOTE:
If the radio has Intersystem roaming capability, the system administrator is able to put the radio into a
nonfunctional state when the missing radio roams to another system.
The radio can only be uninhibited by receiving an uninhibited command from the system administrator.
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Chapter 34

Switching between Repeater and Direct
Operation
Repeater operation increases radio coverage area by connecting with other radios through a repeater. Direct
or "talkaround" operation bypasses the repeater and connects directly to another radio. You can select either
one of these operations on your radio.

Procedure:
Perform one of the following actions:
● Press the programmed Repeater/Direct button.
● From the Home screen, press the Dir menu item.
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Chapter 35

Voice Announcement
This feature enables the radio to audibly indicate the current feature mode, zone, or channel assigned to the
user.
The available voice announcement (VA) priority options are:
High

Voice announcement is enabled even when the radio is receiving calls.
Low

Voice announcement is disabled when the radio is receiving calls.
NOTE: If the Voice Announcement field is set to Enabled, after an interruption by a momentary tone
one of the following scenarios occurs:
● If Suppress Replay field is Enabled, voice announcement replays.
● If Suppress Replay field is Disabled, voice announcement turns off.
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Chapter 36

Site Selectable Alerts
A Site Selectable Alert (SSA) is an Intelligent Lighting indicator with audio alert. The alert is sent to radios at
sites to notify the users when special situations occur.
Your radio supports up to 250 site aliases. Only authorized radios are enabled to send SSA.

NOTE:
The alert alias, alert tone, and alert period are configured in the Customer Programming Software.
Contact your system administrator for more information.
The SSA alert volume is reduced when voice audio is received at the same time. It is important that the
SSA audio file is created with clear loud audio to ensure audio clarity at reduced levels.

36.1

Sending Site Selectable Alert Notification
If you are receiving an alert notification, your radio shows the following indications:
● Alert tone repeats periodically.
● The display shows the alert alias with intelligent lighting on the home screen.

Procedure:
1. Press the SSA menu item.
2. Select Start Alert and pressSel.
3. Perform one of the following actions:

● To send alert notifications to a single site, select the required site alias and press Sel.
● To send alert notifications to all sites, select [All Sites] and press Sel.
● To send alert notifications to all available sites, select [All Avail] and press Sel.

4. Select the required alert alias.
5. Select Send.

Result: The display shows Sending req.
If radio is out of range, roaming to a foreign system or in a failsoft situation, the display shows Req failed.

If the request is successful, the display shows Req successful.

If one or more sites are unavailable, the display shows Not all sites available.

36.2

Stopping Site Selectable Alert Notification
Procedure:

1. Press the SSA menu item.
2. Press Stop Alert → Sel.
3. Perform one of the following actions:

● To stop alert notifications of a single site, select the required site alias.
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● To stop alert notifications of all sites, select [All Sites].
● To stop alert notifications of all available sites, select [All Avail].

4. Press Send.
5. To return to the Home screen, press Exit.

Result: The display shows Sending req.
If radio is out of range, roaming to a foreign system or in a failsoft situation, the display shows Req failed.

If the request is successful, the display shows Req successful.

If the site is not available, the display shows <Site Alias> not available.

If the site does not exist, the display shows <Site Alias>does not exist.
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Chapter 37

Additional Performance Enhancement
The following performance enhancements are some of the latest creations designed to enhance the security,
quality, and efficiency of the radios.

37.1

ASTRO 25 Enhanced Data
ASTRO 25 Enhanced Data is optimized to handle different message sizes and variable update rates from
different applications of the radio. To improve data channel efficiency and enable denser network traffic, add
Enhanced Data to the Integrated Data system with a software installation.

37.2

Dynamic System Resilience
Dynamic System Resilience (DSR) ensures that the radio system is seamlessly switched to a backup master
site dynamically during a system failure. DSR also provides indications such as failure detection, fault
recovery, and redundancy within the system. DSR also supports mechanisms related to the Integrated Voice
and Data (IV&D), or data centric.

37.3

Encrypted Integrated Data
Encrypted Integrated Data (EID) provides security encryption and authentication of Integrated Voice and
Data (IV&D) bearer service. This bridges the communication between the radio and the Customer Enterprise
Network.

37.4

SecureNet
SecureNet allows you to perform secured communications on an Analog or Motorola Data Communication
(MDC) channel.

37.5

P25 Digital Vehicular Repeater System
Motorola Solutions offers an MSI Certified APX compatible, third party, P25 Digital Vehicular Repeater
System (DVRS). This provides low-cost portable radio coverage in areas where only mobile radio coverage is
available.

NOTE: Portable subscriber units enabled in the system for Radio Authentication shall be able to
authenticate regardless of whether they are communicating directly on the system or by using a DVRS.

DVRS can also work with SmartConnect to use broadband coverage for the in-vehicle mobile. Portable
radios communicate through the in-vehicle mobile to the system through the LTE, Satellite, or Wi-Fi
connection. This extends the system coverage when you are away from the vehicle.
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Chapter 38

Accessories
Not all accessories are FCC certified to operate with all radio models, band splits, or both. See the radio price
pages for a list of FCC certified accessories or contact your sales representative for accessory compatibility.

See https://www.motorolasolutions.com to know more about the accessories supported by this radio.
NOTE: GPS only antenna is used in either a single band 700/800 MHz application where the Public
Safety Microphone (PSM) is used with the corresponding PSM antenna. This antenna is only for GPS
reception and cannot be used for receive/transmit operation at 700/800. Do not use this antenna on the
PSM.

MN009363A01-AE
Chapter 38:  Accessories

105

https://www.motorolasolutions.com

	Contents
	List of Figures
	List of Tables
	Legal and Support
	Intellectual Property and Regulatory Notices
	Legal and Compliance Statements
	Disclaimer
	Declaration of Conformity
	ISED WLAN Statement
	Important Safety Information
	Notice to Users (FCC)
	FCC Licensing Information
	Applying for Canadian License

	Limited Warranty
	MOTOROLA SOLUTIONS COMMUNICATION PRODUCTS
	I. WHAT THIS WARRANTY COVERS AND FOR HOW LONG:
	II. GENERAL PROVISIONS:
	III. STATE LAW RIGHTS:
	IV. HOW TO GET WARRANTY SERVICE:
	V. WHAT THIS WARRANTY DOES NOT COVER:
	VI. PATENT AND SOFTWARE PROVISIONS:
	VII. GOVERNING LAW:
	VIII. For Australia Only


	Read Me First
	Software Version

	Radio Care
	1.1 Cleaning Your Radio
	1.2 Radio Service and Repair
	1.3 Battery Recycling and Disposal

	Radio Overview
	2.1 Keypad Overview
	2.2 Programmable Radio Functions
	2.3 ViQi
	2.3.1 Activating Basic Voice Control
	2.3.2 Using ViQi Virtual Partner


	Getting Started
	3.1 Attaching and Removing the Battery
	Attaching the Battery
	Removing the Battery

	3.2 Attaching and Removing the Antenna
	Attaching the Antenna
	Removing the Antenna

	3.3 Attaching and Removing the Accessory Connector Cover
	Attaching the Accessory Connector Cover
	Removing the Accessory Connector Cover

	3.4 Attaching the Belt Clip
	3.5 Charging the Radio
	3.6 Turning the Radio On or Off
	Turning the Radio On
	Turning the Radio Off

	3.7 Adjusting the Volume of the Radio

	Home Screen Overview
	4.1 Status Indicators
	4.1.1 Status Icons
	4.1.2 LED Indications
	4.1.3 Intelligent Lighting Indicators
	4.1.4 Transmit and Receive Indicators


	General Radio Operation
	5.1 Selecting Zones
	5.2 Selecting Channels
	5.2.1 Channel Error Message

	5.3 Mode Select Feature
	5.3.1 Saving Zones and Channels

	5.4 Selecting the Power Level
	5.5 Selecting a Radio Profile
	5.6 Enabling and Disabling the Radio Alias
	5.7 Adjusting the Display Backlight
	5.8 Editing the Time and Date
	5.9 Locking and Unlocking the Controls
	5.10 Setting the Tones for Controls and Buttons
	5.11 Setting the Voice Mute
	5.12 Using the Time-Out Timer
	5.13 Adjusting the Squelch Level
	5.14 Conventional Squelch Operation
	5.14.1 Setting Conventional Squelch Operation

	5.15 Using the PL Disable Feature
	5.16 Digital PTT ID Support
	5.17 General Radio Information
	5.17.1 Accessing the General Radio Information


	Trunking System Controls
	6.1 Operating in Failsoft System
	6.2 Imbalanced Coverage
	6.3 Out-of-Range Radio
	6.4 Site Trunking Feature
	6.5 Site Search
	6.6 Locking or Unlocking Sites
	6.7 Viewing the Current Site
	6.8 Changing the Current Site

	Types of Radio Calls
	7.1 Making Calls
	7.2 Receiving Calls
	7.3 Making Priority Dispatch Calls

	Emergency Operation
	8.1 Special Considerations for Emergency Operation
	8.2 Sending Emergency Alarms
	8.3 Sending Emergency Alarms with Emergency Calls
	8.4 Exiting Emergency Operation
	8.5 Remote Emergency
	8.5.1 Sending Remote Emergency to Specific Users
	8.5.2 Sending Remote Emergency by Entering the User ID
	8.5.3 Manually Refreshing the Remote Emergency List
	8.5.4 Receiving Remote Emergency
	8.5.5 Filtering Remote Emergency Contacts

	8.6 Emergency Keep-Alive
	8.7 Emergency Beacon
	8.7.1 Sending Emergency Beacons
	8.7.2 Receiving Emergency Beacons
	8.7.3 Viewing Received Emergency Beacon


	Fireground
	9.1 Entering Fireground Zone Channel (Conventional)
	9.2 Responding to Evacuation Indicator
	9.3 Sending Evacuation Tone

	Tactical Public Safety (Conventional Only)
	10.1 Using TPS Normal Transmission
	10.2 Using TPS Emergency Transmission

	Man Down (Fall Alert)
	11.1 Radio Alerts When Man Down (Fall Alert) is Triggered
	11.2 Testing Man Down (Fall Alert)
	11.3 Exiting Man Down (Fall Alert)
	11.4 Reinitiating Man Down (Fall Alert)

	Secure Operations
	12.1 Switching Between Secure and Clear Transmission
	12.2 Encryption
	12.2.1 Multikey Feature
	12.2.2 MDC OTAR (Conventional Only)
	12.2.3 Infinite UKEK Retention
	12.2.4 Hear Clear
	12.2.5 Loading Encryption Keys
	12.2.6 Selecting Encryption Keys
	12.2.7 Selecting Keysets
	12.2.8 Erasing Encryption Keys
	12.2.9 Requesting Over-the-Air Rekey


	Scan
	13.1 Turning Scan On or Off
	13.2 Making Dynamic Priority Change (Conventional Scan Only)
	13.3 Deleting Nuisance Channel
	13.4 Restoring Nuisance Channels

	Scan Lists
	14.1 Intelligent Priority Scan
	14.2 Managing the Scan List

	Connectivity
	15.1 SmartConnect
	15.2 Wi-Fi
	15.3 Bluetooth®
	15.3.1 Turning Bluetooth On or Off
	15.3.2 Searching and Pairing the Bluetooth Device
	15.3.3 Turning Bluetooth Audio On or Off
	15.3.4 Viewing and Clearing the Bluetooth Enabled Device Information

	15.4 ASTRO 25 (P25) Programming Over Project 25 (POP25)
	15.4.1 Responding to Upgrade Notifications


	Location
	16.1 Turning Location On or Off
	16.2 Accessing Location
	16.3 Selecting Location Formats
	16.4 Managing Waypoints
	16.5 Location Feature in Emergency Mode
	16.6 Peer-Location on the Display (ASTRO Conventional)
	16.7 MGRS Coordinates

	Mission Critical Geofence (ASTRO 25 Trunking)
	17.1 Entry to the Geofence Area
	17.2 Entry to Mission Critical Geofence
	17.3 Exit from Mission Critical Geofence

	Contacts
	18.1 Viewing Contact Details

	Recent Calls
	19.1 Viewing Recent Calls
	19.2 Deleting Calls

	Sending Status
	Call Alert Paging
	21.1 Sending Call Alert Page
	21.2 Receiving Call Alert Page

	Automatic Registration Service
	22.1 Selecting ARS Mode

	User Login Feature
	23.1 Logging In or Out of the User Login Feature
	Logging In the User Login Feature
	Logging Out of the User Login Feature


	Text Messaging Service
	24.1 TMS Status Icons
	24.2 Accessing Messages

	Monitor Feature
	25.1 Monitoring Channels
	25.2 Monitoring Conventional Mode

	Remote Monitor
	Transmit Inhibit
	27.1 Enabling or Disabling Transmit Inhibit
	27.2 Smart PTT (Conventional Only)

	Dynamic Regrouping (Trunking Only)
	28.1 Classification of Regrouped Radios
	28.2 Requesting a Reprogram (Trunking Only)

	Dynamic Zone Programming
	29.1 Selecting Channels in the Dynamic Zone
	29.2 Deleting Channels in the Dynamic Zone

	Multiple Private Line
	30.1 Selecting Multiple Private Line

	Zone-to-Zone Cloning
	31.1 Cloning Zones

	Radio Kill
	32.1 Using Direct Kill to Kill Your Own Radio

	Radio Inhibit
	Switching between Repeater and Direct Operation
	Voice Announcement
	Site Selectable Alerts
	36.1 Sending Site Selectable Alert Notification
	36.2 Stopping Site Selectable Alert Notification

	Additional Performance Enhancement
	37.1 ASTRO 25 Enhanced Data
	37.2 Dynamic System Resilience
	37.3 Encrypted Integrated Data
	37.4 SecureNet
	37.5 P25 Digital Vehicular Repeater System

	Accessories


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /PageByPage
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /CMYK
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments true
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts false
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Remove
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth 8
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /FlateEncode
  /AutoFilterColorImages false
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth 8
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /FlateEncode
  /AutoFilterGrayImages false
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile (None)
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /CreateJDFFile false
  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000410064006f006200650020005000440046002065876863900275284e8e9ad88d2891cf76845370524d53705237300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef69069752865bc9ad854c18cea76845370524d5370523786557406300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <FEFF9ad854c18cea306a30d730ea30d730ec30b951fa529b7528002000410064006f0062006500200050004400460020658766f8306e4f5c6210306b4f7f75283057307e305930023053306e8a2d5b9a30674f5c62103055308c305f0020005000440046002030d530a130a430eb306f3001004100630072006f0062006100740020304a30883073002000410064006f00620065002000520065006100640065007200200035002e003000204ee5964d3067958b304f30533068304c3067304d307e305930023053306e8a2d5b9a306b306f30d530a930f330c8306e57cb30818fbc307f304c5fc59808306730593002>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020ace0d488c9c80020c2dcd5d80020c778c1c4c5d00020ac00c7a50020c801d569d55c002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken die zijn geoptimaliseerd voor prepress-afdrukken van hoge kwaliteit. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents best suited for high-quality prepress printing.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /ConvertToCMYK
      /DestinationProfileName ()
      /DestinationProfileSelector /DocumentCMYK
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure false
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles false
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /DocumentCMYK
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /UseDocumentProfile
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


